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PENDAHULUAN 

 

Latar Belakang 

Banyak orang seringkali bingung dengan beberapa istilah yang hampir sama. Kita 

seringkali mendengar tentang istilah yang hampir mirip selain desain komunikasi visual, yaitu 

desain grafis dan seni grafis. Istilah desain komunikasi visual sendiri sudah dijelaskan di atas. 

Sedangkan desain grafis sendiri memang salah satu istilah yang paling sering disalahtukarkan 

dengan Desain komunikasi visual. Memang keduanya sangat berhubungan erat, namun 

sebenarnya ada perbedaan di antara keduanya. 

Desain grafis atau Graphic Design. Kata grafis menurut etimologi adalah berasal dari kata 

graphic (bahasa Inggris) yang berasal dari bahasa Latin graphē (yang diadopsi kata Yunani 

graphos), yang berarti menulis, menggores atau menggambar diatas batu. 

Desain sendiri merupakan proses pemikiran dan perasaan yang akan menciptakan sesuatu, 

dengan menggabungkan fakta, konstruksi, fungsi dan estetika untuk memenuhi kebutuhan 

manusia atau Desain grafis juga biasa diartikan suatu konsep pemecahan masalah rupa, warna, 

bahan, teknik, biaya, guna dan pemakaian yang diungkapkan dalam gambar dan bentuk. 

Dalam desain grafis masalahnya mencakup berbagai bidang seperti teknik perencanaan 

gambar, bentuk, simbol, huruf, fotografi dan proses cetak disertai pula dengan pengetahuan 

tentang bahan dan biaya. 

Biasanya Desain grafis biasanya diterapkan untuk media-media statis, seperti buku, 

majalah, dan brosur tetapi sejalan dengan perkembangan zaman, desain grafis juga diterapkan 

dalam media elektronik, yang sering kali disebut sebagai desain interaktif atau desain 

multimedia. 

Tujuan desain grafis selain menciptakan desain atau perencanaan fungsional estetis, 

namun juga yang informatif dan komunikatif dengan masyarakat yang dilengkapi pula dengan 

pemahaman mengenai psikologi massa dan teori-teori pemasaran, sehingga karya-karya desain 

grafis ini bisa merupakan alat promosi yang ampuh. 

Dari sinilah Desain grafis juga seperti jenis desain lainnya merujuk kepada proses pembuatan, 

metode merancang, produk yang dihasilkan (rancangan), atau pun disiplin ilmu yang 

digunakan (desain). 
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BAB V PENGGABUNGAN GAMBAR DAN TEKS BERBASIS VECTOR 
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SEMESTER I 

MODUL 

 

BAB I 

DESAIN GRAFIS DAN NIRMANA 

 

3.1 Menerapkan dasar dasar desain grafis dan nirmana 

3.1.1 Menjelaskan dasar dasar desain grafis dan nirmana 

3.1.2 Menerapkan dasar dasar desain grafis dan nirmana 

4.1. Membuat desain dengan menerapkan dasar-dasar desain grafis dan nirnama 

4.1.1 Mencoba mendesain dengan menerapkan dasar-dasar desain grafis dan 

nirnama 

4.1.2 Membuat desain dengan menerapkan dasar-dasar desain grafis dan nirnama 

 

A. Materi 

1. Konseptual Nirmana 

a. Elemen Titik 

Elemen titik adalah suatu bentuk kecil yang tidak mempunyai dimensi. Dari 

sebuah titik dapat dikembangkan menjadi garis atau bidang. Pada gambar dalam 

bidang gambar akan berawal dari sebuah titik dan berhenti pada sebuah titik. 

Secara umum bentuk diartikan titik karena ukurannya yang kecil. Namun 

pengertian kecil itu sesungguhnya nisbi/bersifat relatif tergantung dibandingkan 

dengan apa dan ukuran seberapa besar. 

Titik yang Bersifat Relatif Terhadap Ukuran Bidang 

Ciri khas dari elemen titik adalah ukurannya yang kecil dan rautnya 

sederhana. Karya seni dapat dihasilkan dengan teknik titik-titik. Dalam mengatur 

titik pada suatu bidang, Anda bebas menentukan jumlah titik dan alat penyentuh. 
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Tujuan yang diharapkan adalah efek dari percampuran titik-titik tersebut yang akan 

menghasilkan warna tertentu. 

b. Raut Titik 

Raut titik yang paling umum adalah bundaran sederhana, mampat, tak 

bersudut, dan tanpa arah. Titik dapat juga beraut bujur sangkar , segitiga, dan lain 

sebagainya. 

 

Raut titik 

c. Elemen Garis 

Garis adalah suatu hasil goresan nyata dan batas limit suatu benda, ruang, 

rangkaian masa, dan warna. Garis bisa panjang, pendek, tebal, tipis, lurus, 

melengkung, berombak, vertikal, horizontal, diagonal, dan lain sebagainya. 

Jika titik-titik diletakkan sejajar secara berimpit, maka akan didapatkan 

sebuah garis. 

 

 

 

 

 

Elemen garis 

Saat menyentuh alat gambar atau alat tulis dan Anda berusaha 

menggerakkannya pada suatu bidang maka akan meninggalkan bekas. Bekas itu 

disebut goresan atau garis. Disebut demikian karena bentuknya yang kecil 

memanjang dan hal ini bersifat nisbi. 

Saat menggunakan alat gambar/alat tulis kecil runcing, tumpul besar, gepeng 

lebar seperti kuas gepeng lebar, semua hasil goresannya digolongkan sebagai garis. 

1) Raut Garis 
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Raut adalah ciri khas suatu bentuk. Raut garis adalah ciri khas bentuk garis. 

Raut garis secara garis besar hanya terdiri dari dua macam, yaitu garis lurus dan 

garis bengkok atau lengkung.  

2) Interval Tangga Raut Garis 

Pada dasarnya raut garis hanya terdiri dari garis lurus dan garis lengkung. 

Garis lengkung bisa terdiri dari lengkung tunggal dan lengkung ganda (lengkung 

S). Perbedaan raut pada garis lurus dan garis lengkung dapat dibuat tujuh interval 

tangga, seperti tangga nada do, re, mi, fa, so, la, si. 

Interval tangga raut garis 

 

Menyusun garis-garis dengan dua atau tiga interval tangga berdekatan, 

misalnya nomor 1 dan 2, nomor 5 dan 6, atau nomor 1,2, dan 3, atau nomor-nomor 

yang lainnya yang saling berdekatan, disebut transisi. Hasilnya harmonis, enak 

dilihat, cocok untuk hal-hal yang perlu dinikmati berlama-lama, seperti interior, 

lukisan, busana, dan lain sebagainya. 

Jika hanya satu nada akan terdengar monoton, jika dua atau tiga nada yang 

berdekatan akan terdengar harmonis, dan jika menggunakan dua nada yang 

bertentangan misalnya nada tinggi dan nada rendah akan terdengar kontras, begitu 

juga pada garis saat garis nomor 1 bersanding dengan 6 atau 7 akan terlihat kontras. 

3) Ukuran Garis 

Ukuran garis bukan berdasar ukuran sentimeter atau meter, tetapi ukuran 

yang bersifat nisbi, yakni ukuran garis yang berupa panjang-pendek, tinggi-rendah, 

besar-kecil, dan tebal-tipis. Seberapa panjang, tinggi, dan besarnya dipengaruhi 

oleh tempat atau ruang di mana garis berada. Sedangkan ukuran tebal-tipis 

dipengaruhi oleh alat dan tekanan penggoresan. Jika alat penggoresnya pensil 

misalnya jenis pensil 2H, H, HB, 1B, 2B, 3B, 4B, atau 5B dan faktor kekuatan 
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tekanan dalam penggoresan. Oleh karenannya, dengan pensil yang sama, tetapi 

tekanan penggoresan yang berbeda, akan dihasilkan ketebalan yang berbeda pula. 

4) Interval Tangga Ukuran Garis 

Menyusun garis dengan dua atau tiga interval garis yang berjauhan disebut 

oposisi, hasilnya kontras, dinamis, keras, kuat, kuat, tajam, namun bisa juga 

menjadi kurang bagus dilihat jika tidak tepat menyusun ukuran garisnya. 

Interval tangga ukuran garis 

5) Arah Garis 

Arah elemen garis hanya ada tiga, yaitu horizontal, diagonal, vertikal. Garis 

bisa lurus, melengkung atau bergerigi, namun arah geraknya dari garis tetap terdiri 

dari tiga arah. 

6) Interval Tangga Arah Garis 

Arah garis dapat berupa arah horizontal, arah diagonal, dan arah vertikal. 

Dari arah horizontal,diagonal, vertikal, dapat dibuat tujuh vertikal tangga arah 

garis. 

Komposisi yang dihasilkan dari menyusun dua atau tiga interval tangga 

saling berdekatan akan menghasilkan transisi yang harmonis, enak dilihat, 

menyenangkan. Komposisi yang dihasilkan dari menyusun dua atau tiga arah garis 

yang saling berjauhan disebut oposisi, hasilnya kontras, dinamis, keras, kuat, tajam, 

namun bisa juga menjadi kurang bagus dilihat jika tidak tepat menyusun arah 

garisnya. 
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Interval tangga arah garis 

7) Gerak Garis 

Gerak garis merupakan arah gerak saat menggoreskan garis tersebut. Gerak 

garis bisa dikatakan irama garis. Arah garis dapat lurus, lengkung, lengkung 

ganda/majemuk, berombak merata, berombak dari kecil ke besar, berombak dari 

besar ke kecil, melingkar-lingkar, patah-patah, bergigi, atau campuran dari 

beberapa aspek. 

❖ Garis dengan teknik goresan media runcing, seperti pensil, pena, rapido, dan 

sejenisnya. 

❖ Garis dengan teknik goresan media lunak,seperti kuas lunak/kuas cat air, spon, 

dan media lunak yang lain. 

❖ Garis dengan media teknik goresan media keras, seperti kayu, besi, lidi, atau 

lainnya. 

❖ Garis dengan teknik goresan pisau palet,dan sejenisnya. 

❖ Garis dengan teknik goresan lilin/pastel minyak dicampur cat air/cat poster. 

❖ Garis dengan goresan malam/paravin, dan canting dicampur cat air/cat poster. 

❖ Garis dengan goresan media garpu, sisir, dan sejenisnya. 

d. Elemen Bidang 

Bidang merupakan bentuk yang menempati ruang, dan bentuk bidang 

sebagai ruangnya sendiri disebut ruang dwimatra/dua dimensi. Bidang hanya 

berdimensi panjang dan lebar. Bidang sebagai ruang adalah ruang dwimatra dan 

merupakan tempat di mana objek-objek berada. 

Bidang yang menempati ruang dapat berbentuk dasar sejajar dengan 

tafril/bidang gambar yang memiliki panjang dan lebar, atau dapat berbentuk maya, 

yaitu bidang yang seolah-olah melengkung, atau bentuk bidang yang seolah-olah 

membuat sedut dengan tafril sehingga seperti memiliki kedalaman. 
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Aplikasi susunan bidang dapat dilihat saat orang menyusun tegel lantai 

maupun dinding, penyusunan lempeng batu alam pada dinding, menyusun pecahan 

mozaik, menyusun foto didinding, ataupun menyusun lukisan. 

a) Raut Bidang 

Secara garis besar macam dari raut bidang terdiri dari geometri dan non-

geometri. Bidang geometri bidang teratur yang dibuat secara matematika. Raut 

bidang geometri atau bidang yang dibuat secara matematika, meliputi segitiga, segi 

empat, segilima, segienam, segidelapan, lingkaran, dan lain sebagainya. 

Bidang geometri 

Bidang non-geometri merupakan bidang yang dibuat secara bebas, dapat 

berbentuk bidang organik, bidang bersudut bebas, bidang gabungan, dan bidang 

maya. 

Bidang sudut bebas 

Bidang organik adalah bidang-bidang yang dibatasi garis lengkung-lengkung 

bebas, bidang bersudut bebas yaitu bidang-bidang yang dibatasi garis patah-patah 

bebas. 

Bidang organik 

Selain bentuk bidang yang rata sejajar dengan tafril/bidang gambar, terdapat 

bidang yang bersifat maya, yaitu bentuk bidang yang seolah meliuk, bentuk bidang 

yang seolah miring membentuk sudut, bentuk bidang yang seolah terpelintir, ada 

lipatan. 

Bidang maya 
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Raut bidang gabungan merupakan segala bentuk alam ini dapat 

disederhanakan menjadi bentuk bidang dengan raut geometri, raut non 

geometri,seperti misalnya rumah, pohon, kuda, gitar, dan lain-lain,yang bersifat 

datar disebut sebagai bidang. 

Bidang gabungan 

b) Ukuran Bidang 

Bidang memiliki dimensi panjang dan lebar yang menutupi area, bentuk 

bidang memiliki ukuran. Ukuran yang dimaksud bukan sentimeter atau meter, 

namun ukuran yang bersifat nisbi, di mana suatu ukuran yang menyesuaikan 

dengan tempat di mana bidang tersebut berada. Ukuran bidang secara nisbi hanya 

ada dua, yaitu luas dan sempit. Ukuran bidang yang sama dapat tampak luas 

manakala diletakkan di area sempit, dan akan tampak sempit jika diletakkan pada 

area yang luas. 

c) Interval Tangga Bidang 

Interval tangga bidang merupakan tangga bidang di antara dua bentuk bidang 

berkontras. Interval tangga bidang dapat diciptakan sendiri secara bebas terhadap 

dua bidang yang dianggap kontras, misalnya tangga bidang di antara segitiga 

dengan lingkaran, segiempat dengan lingkaran, atau bentuk bidang bergerigi 

dengan lingkaran. 

Interval tangga raut bidang 

Dengan berdasar pada interval tangga bidang, antara lain dapat dihasilkan 

susunan bidang sebagai berikut. 
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❖ Susunan repetisi: raut bidang dengan suatu interval tangga (raut bidang 

yang sama). Susunan ini hasilnya monoton, ada kesan resmi, rapi, terlihat 

statis dan menjemukan. 

❖ Susunan transisi: memadukan raut bidang dengan dua atau tiga interval 

yang berdekatan hal ini menghasil harmonis, ada dinamika, dan enak 

dinikmati. 

❖ Susunan oposisi: di mana raut bidang dengan dua interval tangga berjauhan 

(raut bidang yang berbeda), hasilnya kontras, keras, tajam. 

d) Interval Tangga Ukuran Bidang 

Ukuran bidang bersifat nisbi, yang hanya memiliki dua ukuran, yaitu luas 

dan sempit. Dikatakan luas jika bidang tersebut berada di tempat yang sempit dan 

dikatakan sempit manakala bidang tersebut diletakkan pada area yang luas.Di 

antara ukuran yang luas dan yang sempit tersebut dapat kita buat tujuh interval 

tangga ukuran bidang. 

Saat menyusun bidang berdasar interval tangga ukuran ada beberapa hal yang 

harus diperhatikan: 

❖ Menyusun bidang dengan ukuran satu interval tangga (berarti hanya satu 

jenis ukuran), hasilnya monoton, statis, dan berkesan resmi. 

❖ Menyusun bidang dengan dua atau tiga interval bidang yang berdekatan, 

hasilnya harmonis, enak dilihat, dan menyenangkan. 

❖ Menyusun bidang dengan interval saling berjauhan, hasilnya kontras, 

dinamis, kuat, tajam, ada kesan kontradiktif. 

Interval ukuran bidang 

e) Interval Tangga Arah Bidang 

Arah bidang dalam suatu area hanya ada tiga, yaitu horizontal, diagonal, dan 

vertikal. Hal-hal yang perlu diperhatikan saat menyusun bidang dengan perubahan 

arah: 
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❖ Menyusun bidang dengan satu interval tangga (satu arah yang sama) 

hasilnya monoton, statis, terasa menjemukan. 

❖ Menyusun bidang dengan dua atau tiga arah berdekatan hasilnya harmonis, 

enak dilihat, dan menyenangkan. 

❖ Menyusun dua atau tiga bidang dengan arah saling berjauhan, hasilnya 

kontras, kuat, tajam, ada kesan kontradiktif. 

Interval tangga arah bidang 

e. Elemen Gempal 

1) Gempal/volume 

Bentuk rupa gempal/volume merupakan bentuk yang mempunyai tiga 

dimensi yaitu dimensi ruang yang tediri dari panjang, lebar, tebal. Hampir 

semua bentuk yang di alam semesta ini berupa gempal/volume, misalnya kain 

yang tipis tetap mempunyai ketebalan meskipun tipis. 

Pada karya dua dimensi komposisi garis, bidang serta warna akan 

memberikan kesan volume yang bersifat maya atau tidak dapat diraba. Gempal 

semu merupakan bentuk tiga dimensi yang semu sehingga susunan gempal 

semu akan membentuk ruang semu. Pada gambar berikut terlihat susunan 

bidang-bidang yang menciptakan gempal semu, dengan menyusun bidang 

geometri lingkaran dengan ukuran yang berbeda (membesar bagian tengah). 

Dengan menggunakan bidang lengkung bisa juga membentuk suatu bentuk 

gempal maya. 

Penciptaan volume maya pada nirmana dwimatra dengan bidang 

2) Raut Gempal 
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Raut merupakan suatu ciri dari suatu bentuk. Macam-macam raut 

gempal diantaranya adalah: 

 

Gempal kubistis 

 

Bentuk gempal yang bersudut-sudut, seperti kubus, kotak, 

balok, piramida dan lain sebagainya
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3) Tata Rupa Gempal 

Susunan pada gempal baik gempal nyata maupun gempal semu 

mempunyai beberapa pedoman dalam susunan yang sama sebagai berikut: 

a) Susunan repetisi 

Susunan gempal dengan raut yang sama, misalnya susunan balok 

yang berjajar. Susunan repetisi ini akan menghasilkan kesan monoton, 

kaku, statis, namun juga akan terlihat resmi, rapi, teratur. 

Susunan repetisi 

b) Susunan transisi 

Pada susunan gempal transisi, raut gempal memiliki hubungan dan 

ada peralihan bentuk, ada variasi yang sama atau kesamaan tertentu 

misalnya gempal bola dengan gempal setengah bola, gempal silinder 

dengan kerucut. Susunan gempal tansisi akan membentuk suatu susunan  

c) Susunan oposisi 

Susunan oposisi atau disebut juga susunan gempal kontras yang 

saling berbeda bentuk gempalnya, saling bertentangan dan adakalanya 

perbedaan tersebut bertolak belakang. Susunan oposisi akan 

menghasilkan sifat kontras, keras, bergejolak. Contoh dari susunan 

oposisi yaitu susunan gempal dengan bentuk bola dengan kotak, bola 

dengan piramida, dan lain sebagainya. 

Susunan oposisi 
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2. Visual Nirmana 

a. Bentuk dan Raut 

1) Bentuk 

Semua benda yang ada di alam semesta merupakan karya seni/desain, tentu 

mempunyai bentuk. Bentuk apa saja yang ada di alam dapat disederhanakan 

menjadi titik, garis, bidang, gempal. Bentuk kerikil, pasir, debu, dan semacamnya 

yang relatif kecil dan “tidak berdimensi” dapat dikategorikan sebagai titik. Kawat, 

tali, kabel, benangdan semacamnya yang hanya berdimensi memanjang dapat 

disederhanakan menjadi garis. 

2) Titik 

Titik merupakan unsur visual yang ukurannya relatif kecil, tidak memiliki 

panjang atau lebar, dan pangkal dari ujung sebuah garis atau bentuk yang akan 

dibangun. Karya seni rupa berupa gambar atau pun lukisan bermula dari titik. 

Rangkaian titik pada karya seni 

3) Garis 

Garis merupakan bentuk yang memanjang dan mempunyai sifat yang elatis, 

kaku, dan tegas. Pengolahan suatu garis akan menghasilkan garis lengkung, garis 

lurus, garis patah-patah, garis tebal, dan garis tipis. Kesemua jenis garis itu bila 

dikomposisikan dengan tepat dan sesuai akan menghasilkan nilai artistik. 

Fungsi dari sebuah garis dalam karya seni rupa: 

a. Memberikan representasi atau citra struktur, bentuk,dan bidang. Garis ini sering 

disebut garis kontour yang berfungsi untuk memberi batas/tepi gambar; 

b. Menekankan nilai ekspresi seperti nilai gerak atau dinamika (movement), nilai 

irama (rhythm), dan nilai arah (dirrection). Garis ini disebut juga garis grafis; 
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c. Memberikan kesan dimensi dan kesan tekstur. Garis ini disebut pula garis arsir 

atau garis tekstur. Garis tekstur lebih bisa dihayati dengan jalan meraba. 

4) Bidang 

Bidang merupakan suatu bentuk pipih tanpa ketebalan, mempunyai dimensi 

panjang, lebar dan luas, mempunyai kedudukan, arah, dibatasi oleh garis. 

Bidang dalam seni rupa merupakan bagian yang mempunyai sisi lebar dan 

panjang. Bidang dalam karya seni rupa dapat merupakan bidang yang teratur dan 

tidak beraturan. Bidang secara garis besar dapat di dibedakan menjadi 2, yaitu: 

a. Bidang Alamiah 

Bidang yang sudah ada di lingkungan alam sekitar kita, contohnya bidang 

sawah, bidang langit, bidang laut, bidang hamparan pasir pantai, dan lain 

sebagainya. 

Bidang hamparan pasir, bidang air laut, bidang langit 

b. Bidang Buatan 

Bidang buatan adan yang sengaja dibuat dan tidak sengaja dibuat. Bidang yang 

sengaja oleh manusia dibuat, misalnya: bidang lukisan, bidang segitiga, bidang 

lingkaran, dan lain sebagainya. Bidang yang tidak sengaja diibuat timbul karena 

pembubuhan warna, cahaya. 

Bidang karena ada cahaya 

5) Raut 
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Raut adalah ciri khas suatu bentuk. Bentuk apa saja di alam ini tentu memilik 

raut yang merupakan ciri khas dari bentuk tersebut.Bentuk titik, garis, bidang, dan 

gempal, masing-masing raut. Raut merupakan ciri khas untuk membedakan 

masing-masing bentuk dari titik, garis, bidang, gempal tersebut. 

Raut adalah tampang, potongan, bentuk suatu objek. Raut dapat terbentuk 

dari unsur garis yang melingkup dengan keluasan tertentu sehingga membentuk 

bidang. Pada nirmana dwimatra, raut terdapat pada raut elemen titik, elemen garis, 

elemen bidang. 

b. Ukuran dan Tekstur 

1) Ukuran 

Setiap bentuk titik, garis, bidang maupung gempal memiliki sebuah 

ukuran.Ukuran bisa berupa besar, kecil, panjang, pendek, tinggi, rendah. Ukuran 

tersebut bersifat nisbi/relatif artinya ukuran tidak bernilai mutlak. Ukuran 

tergantung terhadap area di mana bentuk tersebut berada. 

Ukuran diperhitungkan sebagai unsur rupa, untuk itu dibuatlah suatu interval 

tangga sebagai panduan untuk mempermudah penyusunan variasi ukuran bentuk 

untuk mendapatkan suatu karya yang indah. Terdapat 7 interval ukuran bentuk 

untuk garis dan bidang, yang dapat dilihat pada gambar berikut: 

Interval ukuran garis 

Interval ukuran bidang 

Anda dapat menyusun suatu karya seni dari bentuk garis maupun bidang 

yang sama dengan ukuran yang berbeda, agar karya tersebut terlihat harmoni dan 
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indah, beberapa hal yang perlu Anda saat menggunakan interval ukuran garis 

maupun bidang. 

a) Menyusun dengan susunan repetisi 

Susunan dengan ukuran yang sama dan bentuk yang sama serta jarak yang 

sama pula, hal ini menghasilkan suatu karya statis, tenang, rapi, resmi tetapi 

menjemukan, monoton. 

Susunan repetis 

b) Menyusun dengan susunan transisi 

Susunan transisi menyusun bentuk-bentuk dengan 2 atau 3 interval tangga 

yang berdekatan, misalkan menggunakan ukuran pada interval nomor 4-5-6. Hal 

ini akan menghasilkan transisi yang harmonis. 

Susunan transisi 

c) Menyusun dengan susunan oposisi 

Susunan oposisi merupakan susunan bentuk-bentuk dengan ukuran dua 

interval tangga yang berjauhan. Susunan oposisi bersifat kontras, kuat, tajam. 

Susunan oposisi 
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Adakalanya saat menyusun bentuk yang mempunyai susunan ukuran yang 

oposisi hasilnya kurang bagus dan kontradiksi. Untuk mengatasi ada beberapa 

hal yang perlu diperhatikan, sebagai berikut: 

❖ Mengulang-ulang dua bentuk kontras ukuran tersebut hingga tercipta 

suatu irama, meski iramanya nanti cukup terasa keras namun dengan 

adanya pengulangan tersebut cukup menetralkan kekontrasan. 

❖ Mengulang ukuran-ukuran besar dalam jumlah yang banyak lalu ditambah 

dengan satu yang berukuran kecil. Atau juga sebaliknya dan hal ini akan 

menjadi suatu dominasi pada suatu karya 

❖ Memberi jembatan yang menghubungkan dua kontras ukuran tersebut. 

Dengan gradasi ukuran sehingga tercipta pengulangan yang bersifat 

progresif dalam hal ukuran. 

2) Tekstur 

Setiap bentuk/benda yang ada di alam semesta ini termasuk karya seni yang 

memiliki raut. Setiap raut memiliki nilai atau ciri ikhas. Ciri khas dari suatu raut 

dapat berupa kasar, halus, polos, bermotif, keras dan lain sebagainya dan hal ini 

disebut tekstur atau barik. 

a) Tekstur kasar nyata. 

Tekstur kasar nyata berguna untuk membantu mendapatkan keindahan 

karena dengan permukaan kasar akan lebih mudah mendapatkan keselarasan 

atau harmoni. 

Tekstur kasar nyata harmoni 

Tekstur kasar juga dapat mengesankan adanya dominasi atau mendapatkan 

daya tarik pada suatu karya. Dominasi ini bisa didapatkan di kala karya yang 

kita buat dipadukan dengan susunan tekstur yang sebagian besar terdiri dari 

tekstur halus. 
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Tekstur kasar dapat pula berguna untuk membantu mendapatkan keindahan 

berpadu dengan kekuatan. Hal ini berguna untuk mendesain produk yang indah 

sekaligus kuat. 

Tekstur pada tutup botol 

Tekstur kasar nyata dapat berwujud tekstur alami dan buatan. Contoh dari 

tekstur alami yang sering dijumpai adalah tekstur kayu, tekstur batu, tekstu kulit 

binatang dan lain sebagainya. Tekstur buatan dapat dibuat dengan pelbagai 

macam cara apa untuk mendapatkan kekasarannya, misalnya ditatah, diukir atau 

pun dibuat meniru alam. 

Tekstur kasar nyata alami - kayu 

b) Tekstur alami seadanya 

Tekstur asli dari bahan dipertahankan. Bahan dapat berupa kertas, kain, daun, 

pasir dan lain sebagainya. Penggunaan bahan dapat dipotong atau pun disobek 

namun tekstur aslinya tetap dimunculkan. 
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Tekstur alami seadanya – pasir 

c) Tekstur alami berubah 

Bahan diubah sehingga tidak sama lagi dengan tekstur aslinya. Tekstur 

aslinya telah diubah dengan pelbagai cara, misalnya kertas dibuat bubur, 

dikusutkan, dicetak timbul dan lain sebagainya. Tekstur pada lempengan logam 

dapat berubah dengan cara dilubangi, dipukuli. Tekstur kayu dapat diubah 

dengan cara diukir. 

d) Tekstur tersusun 

Bahan dapat disusun untuk membentuk suatu pola baru. Pasir, biji-bijian, 

serpihan kayu, kain, kayu dapat disusun menjadi pola baru dan tekstur baru. 

Tekstur dari susunan kertas 

e) Tekstur kasar semu 

Tekstur kasar semu adalah tekstur yang kekasaran teksturnya bersifat semu. 

Tekstur terlihat kasar namun jika diraba teksturnya halus. Terdapat beberapa 

macam tekstur kasar semu, seperti berikut ini: 

❖ Tekstur hias manual 
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Tekstur hias manual merupakan tekstur yang menghiasi permukaan yang 

dibuat secara manual. Contoh dari hias manual diantaranya adalah goresan 

dengan kapas, bentuk goresan silang-silang, goresan dengan spon, dan lain 

sebagainya. 

❖ Tekstur mekanik 

Tekstur mekanik adalah tekstur yang dihasilkan dari proses alat mekanik 

misalnya, jangka, raster, kamera hasil cetakan komputer dan lain 

sebagainya. Berikut contoh tekstur mekanik. Hasil cetakan komputer, foto 

serat kayu, foto tekstur wajah keriput: 

Tekstur dari proses olahan komputer 

Kolase berupa tempelan kertas, kumpulan foto, huruf, dedaunan, dan lain 

sebagainya. 

Kolase kertas 
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Bahan alami yang digosok potong dan digosok halus, misalnya saja kulit 

pohon, bebatuan. 

Tekstur kulit pohon 

f) Tekstur ekspresi 

Tekstur ekspresi merupakan tekstur yang menjadi bagian dari proses 

penciptaan rupa, dimana raut dan tekstur merupakan kesatuan yang tidak dapat 

dipisahkan. Tekstur menjadi raut dan bila tekstur dipisahkan maka raut akan 

berubah dan maknanya tidak sama. Tekstur ekspresi banyak diterapkan pada 

seni lukis, seni grafis, desain komunikasi visual. Tekstur ekspresi dapat berasal 

dari goresan tangan ataupun hasil mekanik. Ada kalanya tekstur ekspresi juga 

bisa kategorikan sebagai tekstur kasar nyata, misalnya saja karya seni yang 

dibuat dari plototan cat sehingga kekasar tekstur dapat dilihat dan diraba pula. 

g) Tekstur halus 

Tektur halus merupakan teksur yang terlihat halus ketika dilihat kasat mata 

maupun diraba.Tekstur halus dapat berupa kesan licin, kusam, mengkilat, 

mulus.Ketika menyusun tekstur halus mengkilat dan berwarna relatif sulit untuk 

menyusun keharmonisannya karena adanya pantulan permukaan. 

Untuk menyusun tekstur suatu permukaan karya seni dapat menggunakan 

acuan interval tangga tekstur yang mirip dengan tangga nada penyusunan musik, 

yaitu do re mi fa so la si do atau diwakili angka dari 1 sampai dengan 7. 

Interval tangga tekstur 
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Kombinasi tekstur halus dengan halus atau kasar dengan kasar 

(menggunakan satu interval saja) akan menghasilkan karya yang monoton, 

terasa menjemukan, kurang ada daya tariknya. 

Kombinasi tekstur yang tangga intervalnya berjauhan, misalnya tekstur halus 

dengan tekstur kasar akan menghasilkan kesan kontras, dinamis, vitalitas dan 

ada daya tarik yang menonjol. Misalnya saja tekstur batu kasar dikombinasikan 

dengan dinding yang halus. 

c. Warna 

Warna merupakan spektrum tertentu yang terdapat di dalam suatu cahaya 

sempurna (berwarna putih). Identitas suatu warna ditentukan panjang gelombang 

cahaya tersebut. Warna dapat didefinisikan secara objektif/fisik sebagai sifat 

cahaya yang dipancarkan, atau secara subjektif/psikologis sebagai bagian dari 

pengalaman indra penglihatan. Secara objektif atau fisik, warna dapat diperikan 

oleh panjang gelombang. Dilihat dari panjang gelombangan, cahaya yang tampak 

oleh mata merupakan salah satu bentuk pancaran energi yang merupakan bagian 

yang sempit dari gelombang elektromagnetik (Sadjiman, 2009). 

Benda berwarna merah karena sifat pigmen benda tersebut memantulkan warna 

merah dan menyerap warna lainnya dalam spektrum cahaya.Benda berwana hitam 

karena sifat pigmen benda tersebut menyerap semua warna pelangi dalam 

spektrum.Sebaliknya suatu benda berwarna putih Karen sifat pigmen benda 

tersebut memantulkan semua warna pelangi atau semua panjang gelombang. 

1) Warna Additive Dan Subtractive 

Warna menurut asal kejadiannya dapat digolongkan menjadi warna 

additive dan subtractive. Warna additive merupakan warna-warna yang 

berasal dari cahaya yang disebut spektrum. Pada warna additive, pencampuran 

warna primer cahaya yang terdiri dari warna red, green dan blue dimana 

pencampuran ketiga warna primer dengan jumlah yang sama menghasilkan 

warna putih atau dikenal dengan sistem warna RGB. Sedangkan warna 

subtractive adalah warna yang berasal dari pigmen yang bersifat transparan. 

Warna pokok subtrative: sian (cyan), magenta, dan kuning (yellow), dalam 

komputer disebut warna model CMY atau lebih dikenal dengan CMYK, K 



 
 

25 | SR 

bukanlah warna tapi unsur prosentase/black/gelap pada masing-masing warna 

subtractive. 

Lingkaran warna additive dan subtractive 

Dari gambar di atas dapat dilihat bahwa warna pokok additive adalah: 

❖ M : merah : red 

❖ B : biru : blue 

❖ H : Hijau : green 

Sedangkan warna pokok dari warna substractive adalah: 

❖ Kn : kuning : Yellow 

❖ Mg : magenta : magenta 

❖ Sa : sian : cyan 

2) Dimensi-dimensi Warna 

Terdapat tiga dimensi warna yang sangat besar pengaruhnya terhadap 

tata rupa, yaitu hue, value, dan chroma. 

Hue adalah realitas/rona/corak warna, yaitu dimensi mengenai 

klasifikasi warna, nama warna, dan jenis warna. Hue merupakan karakteristik, 

ciri khas, atau identitas yang digunakan untuk membedakan sebuah warna dari 

warna lainnya. 

Value adalah tonalitas warna, yaitu dimensi tentang terang-gelap warna 

atau tua-muda warna, atau “ke-terang-an” warna (lightness). 

Chroma adalah intensitas warna, yaitu dimensi tentang cerah redup 

warna, cemerlang suram warna, disebut pula “kecerahan” warna (brightness). 

Intensitas ini disebabkan oleh adanya penyerapan atau peredaman warna 

(saturation). 
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3) Pencampuran Warna Bahan 

Berdasarkan pencampuran warna bahan warna dapat digolongkan 

menjadi beberapa macam, yaitu warna primer, warna sekunder, warna 

intermediate, warna tersier, warna kuarter. Warna bahan sesungguhnya terdiri 

atas dua jenis, yaitu: 

❖ Warna bahan tinta cetak (print computer dan offset). 

Warna primer bahan tinta cetak adalah Cyan, Magenta, yellow (CMY) 

❖ Warna bahan cat (cat air, cat poster, cat akrilik, cat minyak, dan lain-

lain). Warna pokok/primer bahan cat dalam praktik sehari hari adalah 

kuning (yellow), Merah (Red), dan Biru (Blue) atau disebut RGB. 

Pada warna bahan cat warna pokok/primer/pertama adalah kuning, 

merah, dan biru. 

Pencampuran warna bahan 

Skala pencampuran warna 
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Dari gambar skala pencampuran warna-warna, dapat dijelaskan sebagai 

berikut: 

❖ Warna primer/pokok: terdiri dari warna pokok merah, kuning, biru. 

❖ Warna sekunder: pencampuran 2 warna primer. Hijau (H) = biru & 

kuning. Jingga (J) = kuning & merah. Ungu (U) = merah & biru 

❖ Warna tersier: pencampuran 2 warna sekunder. Coklat kuning (CK) = 

jingga & hijau. Coklat merah (CM) = jingga & ungu.. Coklat biru (CB) 

= hijau & ungu. 

❖ Warna kuarter: pencampuran 2 warna tersier. Coklat jingga (CJ) = coklat 

kuning &coklat merah. Coklat hijau (CH) = coklat kuning & coklat biru 

Coklat ungu (CU) = coklat biru & coklat merah. 

4) Klasifikasi Warna-warna 

Terdapat lima klasifikasi warna, yaitu warna primer, sekunder, 

intermediate, tersier, dan kuarter. 

Klasifikasi Keterangan Anggota warna 

Warna primer Disebut warna primer atau pokok - Biru 

 karena warna tersebut tidak dapat - Merah 

 dibentuk dari warna lain. - Kuning 

    

Warna sekunder Sering disebut sebagai warna kedua - Jingga/orange 

 yang merupakan warna jadian dari - Ungu/violet 

 percampuran dua warna primer. - Hijau 

   

Wana Warna intermediate merupakan warna - Kuning hijau 

intermediate perantara, yaitu warna yang ada - Kuning jingga 

 diantara warna primer dan sekunder - Merah jingga 

 pada lingkaran warna. - Merah ungu 
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  - Biru violet 

  - Biru hijau 

Warna tersier Merupakan warna ketiga yang - Coklat kuning 

 dihasilkan percampuran dari dua - Coklat merah 

 warna sekunder atau warna kedua. - Coklat biru 

   

Warna kuarter Warna kuarter atau warna keempat - Coklat jingga 

 yaitu warna hasil percampuran dari - Coklat hijau 

 dua warna tersier atau warna ketiga - Coklat ungu 
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Skema klasifikasi warna 

5) Pembagian Warna Berdasar Area Panas Dan Dingin 

Dari pembahasan jenis-jenis warna mendasarkan pada teori tiga warna 

primer, tiga warna sekunder, dan enam warna intermediate. Kedua belas warna ini 

kemudian disusun dalam satu lingkaran. Lingkaran berisi 12 warna ini jika dibelah 

menjadi dua bagian akan memperlihatkan setengah bagian yang tergolong daerah 

warna panas, dan setengah bagian warna dingin. 

Warna panas memberikan kesan semangat, kuat, dan aktif, warna dingin 

memberikan kesan tenang, kalem, dan pasif. Bila terlalu banyak warna dingin akan 

berkesan sedih dan melankoli. Warna panas berkomplemen dengan warna dingin, 

sehingga sifatnya kontras. 

Warna panas dan dingin 

Dari skema lingkaran 12 warna dingin dan panas ini, secara terperinci 

pembagian berbagai warna menjadi daerah panas dan dingin dalam lingkaran ini 

adalah sebagai berikut. 

❖ Merah, jingga, dan kuning, digolongkan sebagai warna panas, kesannya 

panas dan efeknya pun panas. 
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❖ Biru, ungu, dan hijau, digolongkan sebagai warna dingin, kesannya dingin 

dan efeknya pun dingin. 

❖ Hijau akan menjadi hangat/panas apabila berubah kearah hijau kekuning-

kuningan, dan ungu akan menjadi hangat jika berubah ke arah ungu 

kemerah-merahan. 

6) Warna-Warna dan Artinya 

Tujuan mempelajari nirmana adalah melatih kepekaan artistik dan melatih 

keterampilan teknis pada desain suatu karya, menambah pemahaman tentang 

warna dan penerapannya. 

Warna Arti 

  

Merah   Cepat, enerjik, gairah, marah, berani, bahaya, 

 positif, ageresif, merangsang, dan panas. 

   Lambang keberanian, kemarahan, kekuatan. 

   Bila merahnya adalah merah muda, warna ini 

 memiliki arti kesehatan, kebugaran, keharuman 

 bunga rose . 

Biru   Dingin, pasif, melankoli, sayu, sendu, sedih, tenang, 

 berkesan jauh, mendalam, tak terhingga, tetapi 

 cerah 

   Warna biru mempunyai asosiasi pada air, laut, 

 langit, dan dibarat pada es 

   Melambangkan keagungan keyakinan, keteguhan 

 iman, kesetiaan, kebenaran, kemurahan hati, 

 kecerdasan, perdamaian, kesatuan, kepercayaan, 

 dan lain-lain. 

Kuning   Keadaan terang dan hangat. 

   Gembira, ramah, supel, riang, cerah 

   Energi dan keceriaan, kejayaan, kemegahan, 
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 kemuliaan, dan kekuataan. 

   Kuning tua dan kuning kehijau-hijauan 

 mengasosiasikan sakit, penakut, iri, dan lain-lain. 

Hijau   Berasosiasi pada hijaunya alam, tumbuhan- 

 tumbuhan, sesuatu yang hidup dan berkembang. 

   Hijau mempunyai watak segar, muda, hidup, 

 tumbuh, dan beberapa watak lainnya. 

   Melambangkan kesuburan, kesetiaan, keabadian, 

 

 

   kebangkitan, kesegaran, kemudaan, keremajaan, 

   keyakinan, kepercayaan, keimanan, pengharapan, 

   kesanggupan, kenangan, dan lain-lain. 

Jingga/oranye   Warna jingga memiliki karakter dorongan, semangat  

   merdeka, anugerah, tapi juga bahaya.  

    Jingga menimbulkan sakit kepala, dapat  

   mempengaruhi sistem syaraf, dapat mengetarkan  

   jiwa, menimbulkan nafsu makan.  

    Mengingatkan orang pada buah orange sehingga  

   akan menambah rasa manis jika untuk warna  

   makanan.  

    Menimbulkan kesan murah, dalam arti harga,  

   sehingga banyak digunakan sebagai warna  

   pengumuman penjualan obral.  

Ungu   Ungu memiliki watak keangkuhan, kebesaran, dan 

   kekayaan. 

    Lambang kebesaran, kejayaan, keningratan, 
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   kebangsawanan, kebijaksanaan, pencerahaan. 

    Melambangkan kekejaman, arogansi, duka cita, dan 

   keeksotisan 

Putih   Putih warna paling terang.  

  

  Putih mempunyai watak positif, merangsang, cerah, 

 

   

   tegas, mengalah.  

    Melambangkan cahaya, kesucian, kemurnian,  

   kekanak-kanakan, kejujuran, ketulusan,  

   ketentraman, kebenaran, kesopanan, keadaan tidak  

   bersalah, kehalusan, kelembutan, kewanitaan,  

   kebersihan, simpel, kehormatan.  

Hitam   Formal, kesedihan 

   Serius, tegas 

   Praktis 

   Slim dan sexy 

Abu-abu   Ketenangan  

   Atau ledakan emosi  

   Kemurungan  

   Ketidak ceria  

   Pertanggungjawaban, keamanan,  

    Perak = kemewahan, teknologi tinggi  

    Terkait dengan kedokteran, keperawatan, farmasi  

Coklat   Warna tanah, atau warna natural. 

    Warna coklat adalah kedekatan hati, sopan, arif, 

   bijaksana, hemat, hormat 

    Tetapi memberi kesan terasa kurang bersih. 
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Vektor 

Gambar vektor merupakan gambar digital yang berbasiskan persamaan 

perhitungan matematis. Gambar vektor umumnya berukuran lebih kecil bila 

dibandingkan dengan gambar bitmap. Beberapa format gambar vektor di antaranya: 

.CDR, .AI, .SVG, .EPS, dan dll .Gambar Vektor menggabungkan titik dan garis untuk 

menjadi sebuah objek, sehingga gambar tidak menjadi pecah biarpun diperbesar atau 

diperkecil, tidak seperti gambar Bitmap. Gambar bertipe vektor terbentuk dari garis 

dan kurva hasil dari perhitungan matematis dari beberapa titik, sehingga membentuk 

suatu objek gambar.Vektor menampilkan sebuah gambar berdasarkan perhitungan 

koordinat geometris gambar tersebut.Tampilan gambar vektor, walaupun bersifat 

relatif lebih kaku daripada tampilan bitmap, kualitasnya tidak bergantung kepada 

resolusi gambar. 

Gambar tipe ini bisa diubah-ubah ke berbagai ukuran dan juga dapat dicetak pada 

tingkat resolusi sebesar apapun tanpa kehilangan detil dan ketajaman gambar. 

Tampilan vektor merupakan pilihan terbaik ketika harus menampilkan gambar-gambar 

yang harus bisa mempertahankan ketajaman garis ketika ukuranya diubah. Ketika 

bekerja dengan gambar Vektor, kita akan mengedit objek berdasarkan perhitungan 

matematis-nya. 

Karena monitor menampilkan gambar dengan cara menggunakan jaringan titik, 

maka kedua macam tipe gambar (bitmap dan Vektor) akan diperlihatkan sebagai pixel 

pada layar monitor. Begitu juga ketika kita hendak menampilkan gambar Vektor ke 

suatu halaman web, dimana kita harus melakukan export gambar Vektor tersebut ke 

format yang di dukung oleh browser (JPG, GIF, PNG, dll).Sifat gambar vektor yang 

telah di export tersebut otomatis berubah menjadi tipe bitmap/raster, meskipun dibuat 

dengan program/software penghasil gambar Vektor. 

Berbeda dengan bitmap, vektor grafik merepresentasikan gambarnya tidak dengan 

menggunakan pixel, tetapi dengan kurva dan garis yang didefinisikan dalam 

persamaan matematis yang disebut vektor.Misal untuk menggambar lingkaran maka 

didefinisikan persamaan matematis darilingkaran sehingga membentuk garis pembatas 

lingkaran. Didalam garis pembatas tersebut diberi warna sehingga terbentuklah 

lingkaran.Kedua cara perepresentasian gambar tersebut mempunyai kekurangan dan 

kelebihan masing masing. Pada gambar bitmap sangat baik digunakan untuk 
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merepresentasikan gambar yang sangat kompleks dan detail.Tetapi kekurangannya 

adalah ukuran filenya tergantung dari ukuran gambar dan resolusinya. 

Perbedaan Gambar Vektor Dan Gambar Bitmap 

Banyak aplikasi untuk pengolahan gambar vektor, diantaranya: 

❖ CorelDraw Adalah editor grafik vektor yang dikembangkan oleh Corel, sebuah 

perusahaan perangkat lunak, yang bermarkas di Ottawa, Kanada. 

❖ Adobe Illustrator Adalah program editor grafis vektor terkemuka, dikembangkan dan 

dipasarkan oleh Adobe Systems. 

❖ Macromedia Freehand adalah aplikasi komputer untuk membuat grafik vektor 2 dimensi 

(penggunaan lambang geometris seperti titik, garis, lengkungan dan poligon untuk 

merepresentasikan gambar, dikenal dengan pemodelan geometris) diorientasikan untuk 

pasar pemasaran desktop professional. Telah tersedia untuk Microsoft Windows dan 

Mac OS X.Macromedia FreeHand dapat juga untuk membuat banner, vektor, brosur, 

dan undangan. 

 

B. Evaluasi 

1. Apa yang dimaksud dengan elemen bidang dalam nirmana dan contohkan! 

2. Sebutkan bagian-bagian dari elemen gempal! 

3. Jelaskan perbedaan bentuk dan raut! 

4. Apa yang dimaksud dengan tekstur alami berubah? 

5. Sebutkan warna additive dan subtractive! 

 

 

 

 

 

 

 



 
 

35 | SR 

BAB II 

TIPOGRAFI 

 

3.2 Menerapkan tipografi sesuai media 

3.2.1 Menjelaskan tipografi sesuai media 

3.2.2 Menerapkan tipografi sesuai media 

4.2. Membuat desain menggunakan tipografi yang tepat 

4.2.1 Mencoba mendesain menggunakan tipografi yang tepat 

4.2.2 Membuat desain menggunakan tipografi yang tepat 

 

A. Materi 

1. Sejarah Tipografi  

      Sejarah perkembangan tipografi dimulai dari penggunaan pictograph. Bentuk bahasa 

ini antara lain dipergunakan oleh bangsa Viking Norwegia dan Indian Sioux. Di Mesir 

berkembang jenis huruf Hieratia, yang terkenal dengan nama Hieroglif pada sekitar abad 1300 

SM. Bentuk tipografi ini merupakan akar dari bentuk Demotia, yang mulai ditulis dengan 

menggunakan pena khusus. 

Puncak perkembangan tipografi, terjadi kurang lebih pada abad 8 SM di Roma saat orang 

Romawi mulai membentuk kekuasaannya. Karena bangsa Romawi tidak memiliki sistem 

tulisan sendiri, mereka mempelajari sistem tulisan Etruska yang merupakan penduduk asli 

Italia serta menyempurnakannya sehingga terbentuk huruf-huruf Romawi. 

Saat ini tipografi mengalami perkembangan dari fase penciptaan dengan tangan hingga 

mengalami komputerisasi. Fase komputerisasi membuat penggunaan tipografi menjadi lebih 

mudah dan dalam waktu yang lebih cepat dengan jenis pilihan huruf yang ratusan jumlahnya. 

2. Pengertian Tipografi  

Tipografi merupakan representasi visual dari sebuah bentuk komunikasi verbal dan 

merupakan properti visual yang pokok dan efektif. Hadirnya tipografi dalam sebuah media 

terpan visual merupakan faktor yang membedakan antara desain grafis dan media ekspresi 

visual lain seperti lukisan. Lewat kandungan nilai fungsional dan nilai estetiknya, huruf 

memiliki potensi untuk menterjemahkan atmosfir-atmosfir yang tersirat dalam sebuah 

komunikasi verbal yang dituangkan melalui abstraksi bentuk-bentuk visual. 

Tipografi dibagi kedalam 2 macam jenis, yaitu: "Typography" (Tipografi) merupakan 

suatu ilmu dalam memilih dan menata huruf dengan pengaturan penyebarannya pada ruang-

ruang yang tersedia, untuk menciptakan kesan tertentu, sehingga dapat menolong pembaca 

untuk mendapatkan kenyamanan membaca semaksimal mungkin. 



 
 

36 | SR 

Seni tipografi, yaitu karya atau desain yang menggunakan pengaturan huruf sebagai 

elemen utama. Tipografi atau typography menurut Roy Brewer (1971) dapat memiliki 

pengertian luas yang meliputi penataan dan pola halaman, atau setiap barang cetak. Atau 

dalam pengertian lebih sempit hanya meliputi pemilihan, penataan dan berbagai hal bertalian 

pengaturan baris-baris susun huruf (typeset), tidak termasuk ilustrasi dan unsur-unsur lain 

bukan susun huruf pada pada halaman cetak.  

Peran dari pada tipografi itu sendiri adalah untuk mengkomunikasikan ide atau 

informasi dari halaman tersebut ke pengamat.  Terkadang secara tidak sadar, kita selau 

berhubungan dengan tipografi setiap hari dan setiap saat. Seperti koran atau majalah yang kita 

baca, label pakaian yang biasa kita kenakan dan masih banyak lagi contoh-contoh lainnya. 

3. Trik tipografi  

Tipografi merupakan suatu ilmu dalam memilih dan menata huruf dengan 

pengaturanpenyebarannya pada ruang-ruang yang tersedia, untuk menciptakan kesan 

tertentu,sehingga dapat menolong pembaca untuk mendapatkan kenyamanan 

membacasemaksimal mungkin. 

Dikenal pula seni tipografi, yaitu karya atau desain yang menggunakan 

pengaturanhuruf sebagai elemen utama. Dalam seni tipografi, pengertian huruf sebagai 

lambangbunyi bisa diabaikan. 

Sejarah perkembangan tipografi dimulai dari penggunaan pictograph. Bentuk bahasa 

iniantara lain dipergunakan oleh bangsa Viking Norwegia dan Indian Sioux. Di 

Mesirberkembang jenis huruf Hieratia, yang terkenal dengan nama Hieroglif pada sekitarabad 

1300 SM. Bentuk tipografi ini merupakan akar dari bentuk Demotia, yang mulaiditulis dengan 

menggunakan pena khusus. 

Bentuk tipografi tersebut akhirnya berkembang sampai di Kreta, lalu menjalar 

keYunani dan akhirnya menyebar keseluruh Eropa. 

Puncak perkembangan tipografi, terjadi kurang lebih pada abad 8 SM di Roma 

saatorang Romawi mulai membentuk kekuasaannya. Karena bangsa Romawi tidak memiliki 

sistem tulisan sendiri, mereka mempelajari sistem tulisan Etruska yangmerupakan penduduk 

asli Italia serta menyempurnakannya sehingga terbentuk huruf-huruf Romawi. 

Saat ini tipografi mengalami perkembangan dari fase penciptaan dengan tangan 

hinggamengalami komputerisasi. Fase komputerisasi membuat penggunaan tipografi 

menjadilebih mudah dan dalam waktu yang lebih cepat dengan jenis pilihan huruf yang 

ratusan jumlahnya. 
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Secara garis besar huruf-huruf digolongkan menjadi: 

❖ Roman, dengan ciri memiliki sirip/kaki/serif yang berbentuk lancip pada 

ujungnya.Kesan yang ditimbulkan adalah klasik, anggun, lemah gemulai dan feminin. 

Termasuk didalamnya times new roman. 

❖ Egyptian, dengan ciri kaki/sirip/serif yang berbentuk persegi seperti papan 

denganketebalan yang sama atau hampir sama. Kesan yang ditimbulkan adalah kokoh, 

kuat,kekar dan stabil. 

❖ Serif, Jenis huruf ini memiliki garis-garis kecil yang disebut counterstrokepadaujung-

ujung badan huruf. Garis-garis tersebut berdiri horisontal terhadap badan huruf.Huruf 

serif dikenal lebih mudah dibaca karena kaitnya tersebut menuntun 

pandanganpembaca membaca baris teks yang sedang dibacanya. Contoh: Times New 

Roman,Garamond, Book Antiqua, Bitstream Vera Serif, Palatino Linotype, Bookman 

OldStyle, Calisto MT, Dutch, Euro Roman, Georgia, Pan Roman, Romantic, 

Souevenir,Super French dan lain-lain. 

❖ Sans Serif, dengan ciri tanpa sirip/serif, dan memiliki ketebalan huruf yang samaatau 

hampir sama. Kesan yang ditimbulkan oleh huruf jenis ini adalah modern 

Dalam ilmu desain font ini erat kaitannya dengan ilmu tipografi. 

a. Roman 

Ciri-ciri dari font jenis Roman ini adalah pada bagian ujung suatu huruf terdapat sirip 

atau kaki dengan bentuk lancip, bisa dipastikan huruf tersebut termasuk jenis Roman. 

Selain itu, font Roman ini juga identik dengan kekontrasan tebal dan tipisnya garis-

garis huruf. Font yang termasuk dalam jenis Roman adalah Times New Roman. Font 

ini membuat kesan anggun, klasik dan feminim. 

 

b. Egyptian 
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Jenis huruf Egyptian bisa dilihat dengan ciri kaki yang berbentuk persegi. Bentuk 

persegi tersebut mirip dengan sebuah papan yang memiliki kesamaan tebal. Contoh 

font yang termasuk dalam jenis Egyptian adalah Courier, Campagne, dan Courier New. 

Font ini membuat kesan kuat, kekar, tangguh, dan tidak labil. 

c. Sans Serif 

Sans Serif sendiri berari tanpa sirip. Setiap huruf yang tidak memiliki sirip bisa disebut 

sebagai Sans Serif. Jadi ada begitu banyak jenis font yang masuk kedalam kategori ini. 

Contohnya seperti Arial, Bell Centennial, Calibri, Trebuchet MS, Tahoma, Verdana, 

Helvetica, Univers, Highway, MS Sans Serif, dan Gothic  termasuk ke dalam kategori 

Sans Serif. Jenis huruf ini seringkali dikaitkan dengan kesan kontemporer dan bentuk 

rupa yang efisien. 

d. Script 
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Jenis font ini mudah dikenali. Jika ada sebuah font dengan bentuk hasil goresan tangan 

sudah pasti itu adalah font Script. Font ini memiliki kesan yang terlihat miring. Yang 

termasuk font ini adalah Kuenstler Script, Caflisch Script, dan yang terkenal Lucida 

Handwriting. Font ini memiliki kesan akrab seperti pada surat balas-membalas. 

e. Miscellaneous 

Miscellaneous merupakan jenis font hasil pengembangan dari yang sudah ada. Ciri 

khas font ini adalah hiasan berupa ornamen atau hiasan yang berupa dekorasi. Font ini 

memiliki kesan dekoratif dan artistik.  Contoh yang termasuk jenis font ini adalah 

Braggadocio, Westminster, Kahana, dan masih banyak lagi. 

 

4. Membuat Tipografi Keren dengan Photoshop  

Sebelum memulai siapkan terlebih dahulu bahan-bahanya seperti Background Kota 

Malam Hari Image Source, Font Loobster v 1.4, Font Brannboll Ny Personal Use Only. 

https://www.google.co.id/search?safe=off&sa=G&hl=id&q=frankfurt+am+main&tbm=isch&tbs=simg:CAQSlwEJFWrcXZnCggMaiwELEKjU2AQaBAgACAMMCxCwjKcIGmIKYAgDEiiKFasMgAysDMEK3R6jHosV7hfjFski0zjmPoE36TnyOZor8DjSOJsrGjBS90y15CfVRM5k1f18zBw7DeTB3IpNA6FF7xiqN9xnT8g2wwfDzPOV6P-FfJsQpiUgBAwLEI6u_1ggaCgoICAESBI-qMrUM&ved=0ahUKEwip24yUiqrOAhVHrY8KHVMpAqMQwg4IGSgA&biw=1366&bih=674#imgrc=-ndIadhVtR7eVM%3A
http://www.dafont.com/lobster.font
http://www.dafont.com/brannboll-ny.font
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Cara Membuat Tipografi Keren dengan Photoshop: 

a) Import Gambar  

Import gambar kedalam area kerja Photoshop. Disini saya menggunakan Background 

kota pada malam hari untuk background teks tipografinya. 

 

 

Kemudian atur Brightness dengan cara, pilih menu Image > Brightness/Contrast. 

Geser ke kiri Slider Brightness agar gambar menjadi agak gelap, kemudian ok. Lihat 

perbandingan gambar dibawah sebelum dan sesudah. 

 

b) Buat Objek Untuk Tempat Desain Tipografinya  

https://2.bp.blogspot.com/-pt7suX-lTA8/V6Rw95_vLbI/AAAAAAAADvg/a6F9Lcf8d2MVx-Wb1xXz35fSTnTIUs0bgCLcB/s1600/membuat+tipografi+keren+dengan+photoshop+kumpulan+tutorial+photoshop,+belajar+photoshop+cs3.jpg
https://4.bp.blogspot.com/-OPb53o40zN8/V6Rw9YWOtGI/AAAAAAAADvY/ZsfW2CdNXXsbpDzKZN-xm0dYjcahNeJ0gCLcB/s1600/membuat+tipografi+keren+dengan+photoshop+step+-+1.jpg
https://1.bp.blogspot.com/-_sYMNyV34e4/V6Rw9rgMkbI/AAAAAAAADvc/t9HhZF1zA3A02KexH-MmDo8Kr7_xpfeQQCEw/s1600/membuat+tipografi+keren+dengan+photoshop+step+-+1,2.jpg


 
 

41 | SR 

Buat sebuah lingkaran dengan menggunakan Ellipse Tool (U). Caranya, Pilih Ellipse 

Tool (U) kemudian pada Options Bar pilih tipenya Shape Layes dengan warna putih. 

Klik Tahan lalu tekan shift agar gambar sama bulat (tidak peang) kemudian drag 

pointer mouse untuk membuat objek. Tekan ENTER untuk menghilangkan garis 

patchnya. 

Berikutnya kita buat hiasan seninya yaitu dengan menambahkan bulatan-bulatan 

yang melingkari objek lingkaran tersebut. Caranya, masih menggunakan Ellipse 

Tool, namun kali ini ubah tipenya pada options bar menjadi Patch. 

 

Lalu buatlah objek patch lingkaran dengan tool tersebut, sama dengan cara membuat 

objek llingkaran sebelumnya. Untuk menggeser objek patch tersebut sobat tekan 

CTRL kemudian geser garis patchnya ke tengah-tengah objek lingkaran pertama atau 

dengan menggunakan Patch Selection Tool (A). Bisa juga sobat biarkan, karna 

nantinya juga bisa kita letakan posisinya tepat di tengah-tengah lingkaran. 

 

Sekarang pilih Brush Tool (B), kemudian sobat pilih menu Window > Brushes. Maka 

akan muncul kotak tampilan pengaturan brushnya. Atur Master Diameternya menjadi 

12px, pada Brush tip shape - spacing 150%. Pastikan warna Forground dengan warna 

lain selain putih. Kemudian tekan ENTER. Jadinya seperti gambar dibawah. 

http://belajar-dotcom.blogspot.com/2016/06/fungsi-fungsi-tool-pada-photoshop.html
http://belajar-dotcom.blogspot.com/2016/06/fungsi-fungsi-tool-pada-photoshop.html
http://belajar-dotcom.blogspot.com/2016/06/fungsi-fungsi-tool-pada-photoshop.html
http://belajar-dotcom.blogspot.com/2016/06/fungsi-fungsi-tool-pada-photoshop.html
https://3.bp.blogspot.com/-t9B6f9Q5e0M/V6Rw-_2m0xI/AAAAAAAADwk/lIS2vB9-3WIUDrSSesgc8Kiu2R68eUZjgCEw/s1600/membuat+tipografi+keren+dengan+photoshop+step+-+2,1.jpg
https://4.bp.blogspot.com/-aI1oa-HE6Ew/V6Rw-6GCN2I/AAAAAAAADwk/_kiEjYEe8Y04oL4SmLBpM43Yqkl5ccVGACEw/s1600/membuat+tipografi+keren+dengan+photoshop+step+-+2,2.png
https://2.bp.blogspot.com/-BzAQm9mwRts/V6RxBJQdulI/AAAAAAAADwk/K9On8-NB-6st5ngBv5tRSyAY6siySQOXQCEw/s1600/membuat+tipografi+keren+dengan+photoshop+step+-+2,3.jpg
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Oke sekarang perhatikan! Jika objek lingkarang yang mengelilingi lingkarang 

pertama tadi tidak pas di tengah sobat simak cara berikut. Aktifkan layer lingkaran 1 

dan lingkaran kecil-kecil tadi, cara mengaktifkan dua layer sekaligus caranya klik 

layer yang ingin di aktfikan pertama kemudian tekan CTRL lalu klik pada layer 

berikutnya.   

 

Lalu klik Align Vertical Centers dan Align Horizontal Centers, Lihat gambar 

dibawah. 

Kemudian tekan CTRL lalu klik pada layer objek bulat-bulat yang baru kita buat tadi, 

tujuannya untuk membuat seleksi seperti objek tersebut. Sekarang pilih layer 

lingkaran yang pertama tadi kita buat, kemudian tekan DEL atau Delete. Lalu hapus 

layer objek bula-bulat kecil tadi. Hasilnya seperti gambar dibawah.   

 

https://1.bp.blogspot.com/-VOcZlrx8KaU/V6RxBT76TuI/AAAAAAAADwk/2NHTBUMKnd8NQQ3A-eDEqUaSia2zqsjSwCEw/s1600/membuat+tipografi+keren+dengan+photoshop+step+-+2,4.png
https://3.bp.blogspot.com/-USOzP3fA0rU/V6RxCzho7NI/AAAAAAAADwk/0bTt2m4cZiIo0ehCBFAVv1cqQaQDKO5EgCEw/s1600/membuat+tipografi+keren+dengan+photoshop+step+-+2,5.jpg
https://1.bp.blogspot.com/-aa6k_I22g2E/V6RxCcnlRvI/AAAAAAAADwk/3hil7Qekf6ACEaML47jmDGqUIYZWB7a8QCEw/s1600/membuat+tipografi+keren+dengan+photoshop+step+-+2,5,2.jpg
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Sekarang buat lingkaran patch lagi dengan ukuran yang lebih besar dari lingkaran 

pertama, lihat gambar dibawah. Buat layer baru kemudian cara membuat garis 

Patchnya sama seperti membuat objek bulatan kecil yang mengelilingi lingkaran 

pertama tadi. Namun kali ini pada pacing brushnya buat 1%. kemudian Tekan 

ENTER (forground berwarna putih). Untuk meletakan posisinya agar pas di tengah-

tengah sudah saya sampaikan di atas caranya. 

 

c) Terakhir jadikan satu semua objek lingkarannya. Pilih layer-layer lingkaran, 

kemudian tekan CTRL + E untuk menggabungkan semua layernya menjadi 1. 

Buat Teks Tipografinya  

Pilih Text Tool (T) kemudian ketikan teks "Belajar" dengan menggunakan Font 

Brannboll Ny Personal Use Only. Untuk seni lekukan kebawahnya saya 

http://belajar-dotcom.blogspot.com/2016/06/fungsi-fungsi-tool-pada-photoshop.html
https://1.bp.blogspot.com/-xmEmGBdUYtk/V6RxDPEZv4I/AAAAAAAADwk/fscFxAlEfrU7WG-lLcABGNy2xZgP__hdACEw/s1600/membuat+tipografi+keren+dengan+photoshop+step+-+2,6.jpg
https://4.bp.blogspot.com/-1lzW8_ti2CI/V6RxDndHiYI/AAAAAAAADwk/OguKBjgdiuMHtRgnpVLc0Zpm03nXF-HwQCEw/s1600/membuat+tipografi+keren+dengan+photoshop+step+-+2,7.jpg
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menggunakan angka 6. Kemudian untuk Teks "Semangat" saya menggunakan font 

Loobster v 1.4. 

 

Berikutnya kita buat hiasan pada teks Semangat. Pilih Pen Tool (P) kemudian pada 

options bar pilih Shape Layers. Buatlah objek seperti gambar dibawah, cara 

membuatnya sama seperti sobat membuat seleksi. Klik pada satu titik kemudian 

teruskan pada titik selanjutnya, agar garisnnya tidak melenceng gunakan SHIFT. 

Disini saya mempraktekannya pada bidang kosong, sobat bisa membuatnya pada 

lembar kerja tadi. 

Jika sudah selesai buat menjadi satu layer, caranya sama seperti kita membuat objek 

lingkaran tadi menjadi satu. Duplicate menjadi dua kemudian letakan di posisi kanan 

dan kiri teks Semangat. Lihat hasilnya seperti gambar dibawah. 

Berikutnya kita membuat objek bintang. Cara membuat objek shape sudah saya 

jelaskan, jadi berikutnya hanya saya jelaskan bagian mana yang belum di jelaskan 

saja. Pilih Polygon Tool (U) kemudian pada kolom sides isi nilainya menjadi 5 lalu 

centang star. Buat 5 bintang dengan ukuran yang berbeda. 

 

http://belajar-dotcom.blogspot.com/2016/01/cara-seleksi-foto-dengan-rambut-berantakan-di-photoshop-cs3.html
http://belajar-dotcom.blogspot.com/2016/06/fungsi-fungsi-tool-pada-photoshop.html
https://1.bp.blogspot.com/-W_ai0hMfby4/V6RxD9atmEI/AAAAAAAADwk/fPg5RgbNwEs8LgNk-g7FIbrB31KlAoXGACEw/s1600/membuat+tipografi+keren+dengan+photoshop+step+-+3,1.jpg
https://3.bp.blogspot.com/-t39sjd8s-Xc/V6RxD8_5foI/AAAAAAAADwk/H-IUGy-RrQsztvubJtfV8mhlUAj-iIyNwCEw/s1600/membuat+tipografi+keren+dengan+photoshop+step+-+3,2.png
https://4.bp.blogspot.com/-CuomygkKgLI/V6RxEeEROVI/AAAAAAAADwk/iXfWGJ6hO1IMnaeaMWW4ZNnrz1U7ezK9QCEw/s1600/membuat+tipografi+keren+dengan+photoshop+step+-+3,3.jpg
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Buat objek setengah lingkaran dibawah objek bintang. Gunakan Ellipse Tool untuk 

membuat objek terebut, kemudian potong dengan menggunakan Rectangular 

Marquee Tool. 

 

d) Cliping Mask Objek dan Teks Tipografi  

Jika sudah jadi ornamen hiasan (tidak termasuk objek lingkaran pertama) dan teks 

tipografinya sekarang kita Cliping Mask semua objek tersebut, tujuannya agar tampat 

menjadi transparan. Jadikan sati layer semua objek ornamen dan teks tipografinya, 

aktifkan semua layernya kemudian tekan CTRL + E. Sudah saya sampaikan di atas 

caranya. 

 

Sekarang hanya ada Tiga layer saja yaitu layer layer Ornamen dan Tipografi, 

Background, dan layer lingkaran. Duplicate layer Background dengan cara menekan 

CTRL + J. Letakan layer tersebut di atas layer ornamen dan tipografi. 

 

http://belajar-dotcom.blogspot.com/2016/06/fungsi-fungsi-tool-pada-photoshop.html
http://belajar-dotcom.blogspot.com/2016/06/fungsi-fungsi-tool-pada-photoshop.html
http://belajar-dotcom.blogspot.com/2016/06/fungsi-fungsi-tool-pada-photoshop.html
https://4.bp.blogspot.com/-RekctAL1FdU/V6RxFWIWmII/AAAAAAAADwk/Fa2Rv81REOwhUxxbFmknhim4CGLiD3VwACEw/s1600/membuat+tipografi+keren+dengan+photoshop+step+-+3,4.jpg
https://4.bp.blogspot.com/-nXPICKJKaUA/V6RxFVh_pnI/AAAAAAAADwk/_HapEUxaglIVmc04VpaxOzCPNke_rdtLgCEw/s1600/membuat+tipografi+keren+dengan+photoshop+step+-+3,5.jpg
https://3.bp.blogspot.com/-aGawEAGkVA4/V6RxFahhXdI/AAAAAAAADwk/KS7-3GW_pHkkm0rGrdvrBND0imz5iprswCEw/s1600/membuat+tipografi+keren+dengan+photoshop+step+-+3,6.png
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Selanjutnya klik kanan pada layer background yang di copy > Create Cliping Mask. 

Berikutnya kita buat Layer Style Stroke pada layer Ornamen dan Tipografi. Klik 

kanan pada Layer Ornamen dan Tipoografinya > Blending Options > Stroke. Atur 

size strokenya sesuai keinginan, lalu buat warnanya dengan warna putih, klik ok. 

B. Evaluasi 

1. Apa itu tipografi? 

2. Jelaskan secara singkat sejarah tipografi! 

3. Jelaskan perbedaan penggunaan huruf roman dan sans serif! 

4. Jelaskan karakter jenis huruf! 

5. Buatlah sebuah sketsa desain tipografi! 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://belajar-dotcom.blogspot.com/2016/07/fungsi-layer-style-photoshop.html
https://2.bp.blogspot.com/-74SaiMSQPVA/V6RxGT1vltI/AAAAAAAADwk/_x3yldSwsVcxn3F3lop57QD6rEm9oYTOQCEw/s1600/membuat+tipografi+keren+dengan+photoshop+step+-+3,7.jpg
https://2.bp.blogspot.com/-pt7suX-lTA8/V6Rw95_vLbI/AAAAAAAADvg/a6F9Lcf8d2MVx-Wb1xXz35fSTnTIUs0bgCLcB/s1600/membuat+tipografi+keren+dengan+photoshop+kumpulan+tutorial+photoshop,+belajar+photoshop+cs3.jpg
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BAB III 

GAMBAR SKETSA DAN ILUSTRASI 

 

3.3 Menerapkan prinsip gambar sketsa dan illustrasi 

3.3.1 Menjelaskan prinsip gambar sketsa dan illustrasi 

3.3.2 Menerapkan prinsip gambar sketsa dan illustrasi 

4.3. Menggambar sketsa dan illustrasi 

4.3.1 Menjelaskan sketsa dan illustrasi 

4.3.2 Menggambar sketsa dan illustrasi 

 

A. Materi 

1. Gambar Sketsa 

Sket (sketch) merupakan gambaran atau lukisan yang kasar, ringan, semata-mata 

garis besar atau belum selesai. Kadang kala hanya digunakan sebagai pengingat-ingat 

saja. Sketsa atau sket (sketch) secara umum dikenal sebagai bagan atau rencana bagi 

sebuah lukisan. Dalam pengertian itu, sketsa lebih merupakan gambar kasar, bersifat 

sementara, baik diatas kertas maupun diatas kanvas, dengan tujuan untuk dikerjakan lebih 

lanjut sebagai lukisan. Manfaat sketsa adalah sebagai berikut: 

• Untuk memberikan gambaran tema 

• Meminimalisir kesalahan 

• Mempertajam pengamatan 

• Meningkatkan kemampuan mengkoordinasi hasil pengamatan dan ketrampilan 

tangan 

Ada beberapa aturan yang perlu diperhatikan dalam membuat gambar sketsa : 

• Membuat kerangka gambar yang terdiri dari garis-garis vertikal, horizontal, 

diagonal maupun garis melengkung secara tipis-tipis. 

• Menggambar garis sekundernya, misalnya melukis kerangka kotak/kubus dalam 

keadaan tipis. 

• Menebalkan garis-garis sketsa yang sudah benar. Ketebalan sesuai dengan karakter 

jenis garis yang diinginkan 

Terdapat beberapa peralatan yang dibutuhkan untuk membuat gambar sketsa : 

• Media gambar : kertas gambar (kertas HVS, kertas manila, kertas padalarang, kertas 

roti, kertas kalkir, kertas sketsa). 

• Alat gambar manual : pensil, rapido. 
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• Alat gambar digital : komputer dengan program Computer Aided Design (CAD), 

digital pen, software design grafis. 

• Alat bantu gambar : light box, scanner, meja gambar, mesin gambar, mistar gambar 

segitiga, busur derajat, mal, sablon, dan penghapus. 

 

Kekuatan garis bergantung pada kertas yang dipergunakan. Makin kasar kertas 

yang digunakan, makin gelap goresan pensil yang diperoleh. Sebaliknya makin licin 

kertas, makin abu-abu goresan itu. Secara umum teknik memegang pensil dibedakan 

menjadi 2 macam yaitu : 

1) Memegang pensil seperti menulis, cara ini 

sangat sesuai jika Anda ingin menghasilkan 

gambar yang detail. 

 

 

 

 

 

2) Memegang pensil antara ibu jari diatas dan 

4 jari dibawahnya, teknik seperti ini sangat 

baik untuk membuat garis-garis yang berani 

 

 

 

 

Memberi tekanan yang berbeda ketika memegang pensil juga menghasilkan arsir 

yang berbeda. Semakin kuat tekanan maka arsir yang dihasilkan tebal sebaliknya jika 

tekanan lemah maka arsir yang dihasilkan tipis. 

Jika Anda memang baru pertama kali mulai menggambar dengan pensil, 

kemungkinan garis yang Anda hasilkan pun terlihat kaku dan garis terputus-putus. 

Masalah ini dapat menghilang secara perlahan jika Anda sering berlatih dan tangan Anda 

pun terasa lemas dalam menghasilkan garis. Kesalahan seorang pemula biasanya terlalu 

mengkhawatirkan apakah gambar itu bagus atau tidak dan apakah gambar nya salah atau 

benar. Biasanya pemula takut untuk membuat garis berulang-ulang dan selalu ingin 

menggunakan penghapus. Sebaiknya hilangkan perasaan takut untuk membuat kesalahan 

dan jangan gunakan penghapus terlebih dahulu. 
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a. Sketsa Bentuk 

Bentuk-bentuk obyek alam benda adalah benda mati yang tidak dapat bergerak, 

sehingga lebih mudah untuk dibuat gambarnya karena kita dapat menganalisa obyek 

tersebut dengan lebih baik. 

Dengan menggunakan kelima panca indra anda, cobalah untuk 

memahami/menganalisa sebuah obyek benda mati yang akan anda gambar. Biasakan 

untuk melihat, menyentuh, meraba, mencium, mendengar dan merasakan sebuah 

obyek sebelum mulai menggambar. Kegiatan ini akan membantu anda dalam 

memahami karakter obyek dan mengungkapkan karakter obyek tersebut dalam bentuk 

gambar.  

Dalam mentransformasikan wujud tiga dimensional menjadi gambar dua 

dimensional pengetahuan dan keterampilan tentang perspektif sangat membantu untuk 

menciptakan ilusi keruangan. Selain itu, kemampuan membuat skala dari ukuran 

sebenarnya menjadi lebih kecil atau lebih besar adalah hal penting. Biasanya 

menggambar alam benda jarang menerapkan ukuran yang lebih besar dari obyek 

aslinya, paling besar sama dengan ukuran sebenarnya (life size). Menggambar alam 

benda yang ukurannya lebih kecil dan disesuaikan dengan ukuran kertas, pengukuran 

skalanya dapat dilakukan dengan teknik yang sangat sederhana tetapi efektif. Dengan 

hanya menggunakan batang pensil, tangan direntangkan lurus ke depan dan pensil 

dipegang tegak lurus diarahkan kepada benda yang digambar, mata dipicingkan lalu 

ibu jari digunakan untuk menandai ukuran benda yang digambar pada batang pensil 

itu kemudian digunakan sebagai skala gambar pada kertas gambar. 

Sebagai contoh, anda ingin membuat gambar sketsa sebuah cangkir seperti 

gambar dibawah: 
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Posisikan obyek cangkir tersebut sedemikian rupa sehingga tampak menarik. 

Amati bentuknya, raba permukaannya untuk lebih memahami cangkir tersebut. 

Sebelum memulai menggambar perhatikan komposisi dari cangkir tersebut, ukurlah 

dengan menggunakan pensil yang akan dipakai untuk menggambar. 

Selanjutnya ukuran tersebut dipindahkan ke kertas yang akan digunakan untuk 

menggambar. Buatlah garis bantu dengan goresan tipis saja, agar mudah dihapus 

 

 

 

 

 

 

 

 

 

 

 

 

Setelah garis bantu siap, mulailah membuat sketsa gambar cangkir tersebut: 
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b. Sketsa Makhluk Hidup 

Makhluk hidup (tumbuhan, binatang dan manusia) lebih membutuhkan 

kecermatan jika ingin dituangkan dalam media gambar. Menggambar tumbuhan dan 

binatang ada perbedaannya, misalnya tumbuhan yang diam dapat diamati secara tetap, 

sedangkan binatang tidak karena selalu bergerak. Oleh sebab itu, untuk menggambar 

binatang secara langsung lebih memerlukan kecepatan dan ketajaman penglihatan 

dibanding menggambar tumbuhan. 

Menggambar tumbuh-tumbuhan sama dengan menggambar obyek lainnya. 

Yang penting adalah bagaimana melakukan persepsi terhadap bentuk, warna dan 

karakter dari setiap jenis dan kelompok tumbuhan itu, kemudian dipindahkan ke atas 

bidang gambar. 

Menggambar manusia memerlukan keterampilan dan ketekunan yang lebih 

dibanding menggambar obyek lainnya. Hal ini disebabkan karena bentuk tubuh 

manusia memiliki anatomi tubuh dan plastisitas yang kompleks dan sekaligus indah. 

Untuk dapat menguasainya dibutuhkan pengetahuan tentang anatomi plastis tubuh 

manusia, yaitu tentang fenomena permukaan bentuk tubuh manusia. 
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Anatomi tubuh manusia memang rumit, namun demikian, untuk memudahkan 

memahami dan menggambarnya perlu diketahui terlebih dahulu bentuk dasarnya. 

Bahwa bentuk dasar tubuh manusia jika dikembalikan ke bentuk esensinya dapat 

menjadi rangkaian bentuk silinder bervolume serta terbentuk oleh otot-otot utama 

sebagai gambar berikut: 

Berikut ini adalah contoh urutan yang dapat dilakukan jika ingin menggambar 

wajah manusia : 
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c. Sketsa Suasana Ramai 

Tema sketsa lebih banyak dikaitkan dengan subyek yang diangkat dari 

penggarapan obyek-obyek outdoor. Dalam hal ini, pemandangan diluar seperti kebun, 

ladang, perkampungan padat, keramaian kota, gedung-gedung dan kesibukan orang 

dipasar merupakan obyek menarik yang menggugah pelukis untuk membuat sketsa 

melalui pengalaman langsung. Kontak langsung melalui pengamatan untuk 

mendapatkan impresi dan mengembangkan imajinasi menjadi bagian penting dari 

proses penciptaan dan pemilihan tema dalam sketsa. Dalam proses kerja seperti ini 

tentulah banyak diperoleh keuntungan, antara lain mempertajam pengamatan, 

meningkatkan kepekaan dan kemampuan koordinasi mata dan ketrampilan tangan. 

Terdapat dua pendekatan dalam menggunakan garis sebagai media ungkapan 

sketsa, yaitu pendekatan kontur dan pendekatan gestur. Pada pendekatan kontur, sketsa 

dihadirkan dengan garis-garis tunggal seakan tak terputus, sebagai batas yang 

mengelilingi bentuk subyek-subyeknya tanpa harus kehilangan spontanitasnya. Garis-

garis yang dibentuk secara free-hand ini tampak eksplisit, tajam dan presisi. Tak ada 

garis yang salah. Tak ada garis yang diulang dan berlebihan, apalagi arsir. 

Dalam menggambar suasana keramaian, gambarlah secara keseluruhan, 

hindarkan keinginan untuk menggambar secara detail. Pertimbangkan obyek-obyek 

gambar yang akan ditampilkan dalam gambar sketsa maupun yang hendak 

dihilangkan. Ada banyak jenis pohon, bukit, rumah, sungai, sawah dan lain-lain. 

Semuanya dapat menjadi obyek gambar yang menarik. 
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2. Gambar Ilustrasi 

Ilustrasi  berasal  dari  bahasa  latin  ilustrare  yang  artinya  penampakan, 

kemuliaan, cahaya, penerangan dan penggambaran secara hidup-hidup. Ilustrasi 

merupakan seni membuat gambar yang berfungsi memperjelas dan menerangkan naskah. 

Ilustrasi dipergunakan untuk memperjelas pesan. Ilustrasi dapat membantu retensi. yaitu 

memudahkan pembaca untuk mengingat konsep atau gagasan yang disampaikan melalui 

ilustrasi. Jenis ilustrasi sangat banyak, antara lain gambar, foto, grafik. 

Gambar ilustrasi adalah suatu karya seni rupa dua dimensi, yang berupa gambar 

tangan (manual), ataupun gambar dari hasil olah digital (dari komputer, atau fotografi) 

atau kombinasi dari keduanya manual dan digital, baik hitam putih maupun berwarna 

yang mempunyai fungsi sebagai penerang/penghias untuk memperjelas atau memperkuat 

arti atau memperbesar pengaruh dari suatu teks atau naskah/cerita yang menyertainya. 

Gambar ilustrasi ada beberapa jenis yaitu ilustrasi untuk cerita, ilustrasi untuk ilmu 

pengetahuan, dan ilustrasi untuk sampul buku. Ilustrasi untuk cerita dimaksudkan sebagai 

penjelasan secara visual tentang isi suatu cerita dan dapat diklasifikasikan menjadi 

beberapa jenis yaitu ilustrasi cerita pendek, ilustrasi cerita komik dan ilustrasi cerita fiksi 

atau khayalan. Untuk mengambar ilustrasi cerita novel dan cerita pendek, illustrator harus 

mampu mengambil bagian yang menarik dan dapat mewakili cerita keseluruhan untuk 

dilustrasikan. Ada beberapa langkah dalam membuat gambar ilustrasi, yaitu : 

• Gagasan 

Gagasan bersumber dari bahan yang akan diilustrsikan. Setelah ada gagasan, 

tentukanlah adegan apa yang akan digambar, siapa saja tokohnya, bagaimana 

suasananya, tentukan pula corak gambar dan media yang akan kamu gunakan. 

• Sketsa 

Proses menggambar yang paling awal adalah mengsket atau membuat rancangan 

gambar (sketsa) dengan menggunakan pensil warna atau langsung menggunakan 

media yang akan dipakai. Gagasan yang ada dituangkan bersamaan dengan proses 

mensket. Rencanakan gambar baik-baik. Buatlah coretan kira-kira bagaimana tata 

letak objek yang digambar dan bagaimana gerak yang terjadi. Satukan semua unsur 

gambar yang direncanakan. Beri detail sehingga gambar lebih sempurna. Beri gambar 

sesuai corak yang telah ditentukan. Setiap unsur harus bercorak sama agar tak 

terkesan seperti kolase. 
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• Pewarnaan 

Setelah sket di anggap selesai, kita dapat mewarnai. Pewarnaan dalam menggambar 

ekspresi dapat dilaksanakan dengan dua corak, yaitu corak realis da corak bukan 

realis (ekspresionisme, impresionisme, abstrakisme, dan lain-lain). Pewarnaan corak 

realis harus sesuai dengan keadaan nyata. Sedangkan pewarnaan corak bukan realis 

lebih bebas atau tidak terikat oleh warna aslinya. 

 

a. Gambar Ilustrasi Manual 

Ada beberapa teknik dalam membuat gambar ilustrasi, yaitu dengan cara 

gambar tangan (manual), dengan bantuan alat digital berupa foto dan komputer, atau 

kombinasi dari manual dan digital. Dibawah ini adalah beberapa teknik gambar 

ilustrasi yang dibuat secara manual. 

• Teknik Out line, adalah cara menggambar secara global, atau tidak detail dan 

hanya menggambar garis luarnya saja, sehingga terkesan datar, karena tidak ada 

pengaturan gelap terang 

 

• Teknik arsir, adalah cara menggambar dengan menggunakan arsir atau unsur garis 

yang terputus-putus, yang digoreskan secara teratur dan berulang-ulang, garis-

garis saling menumpuk, digunakan untuk mewujudkan efek gelap terang, volume 

dan plastisitas 



 
 

56 | SR 

 

• Teknik blok, adalah cara menggambar dengan memanfaatkan warna secara blok, 

tanpa menerapkan gradasi dan transisi sehingga terasa datar, bagian yang satu 

dengan yang lain pada suatu objek ditunjukkan dengan perbedaan warna 

 

• Teknik scraperboard, adalah cara menggambar dengan menggoreskan bentuk-

bentuk garis yang arahnya mengikuti volume obyek, garis-garis tidak saling 

menumpuk, tetapi dibuat saling sejajar, dan pada bagian yang gelap dibuat lebih 

rapat, sedang pada bagian yang terang garis dibuat agak renggang, sehingga 

dicapai plastisitas yang dikehendaki. 
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• Teknik dot, yaitu cara mewujudkan gambar dengan menyusun titik-titik sehingga 

membentuk suatu obyek tertentu, kesan gelap dan terang ditentukan oleh jumlah 

titik dalam satu area, semakin banyak semakin kuat kesan gelap terang. 

 

• Teknik goresan kering (dry brush), adalah cara menggambar dengan 

memanfaatkan tinta atau cat yang sengaja dibuat agak kering, sehingga warna-

warna ketika digoreskan tidak merata, efek ini juga digunakan untuk membuat 

tekstur, pada bagian yang terang digoreskan warna-warna terang, sedang pada 
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bagian yang gelap digoreskan warna-warna yang tua dan berulang-ulang, sehingga 

tercapai plastisitas yang diinginkan. 

 

• Teknik half tone, adalah cara menggambar dengan memanfaatkan efek transisi 

warna dari terang ke gelap, dengan menggunakan tinta atau cat yang dibuat agak 

encer, efek transisi warna tersebut digunakan untuk mencapai plastisitas yang 

diinginkan 

 



 
 

59 | SR 

• Teknik siluet, adalah cara menggambar dengan mewujudkan warna tunggal yang 

solid atau pekat, biasanya warna hitam tetapi tidak menutup kemungkinan 

menggunakan warna lain, gambar yang dihasilkan dengan teknik ini hanya berupa 

bentuk global dengan warna tunggal, objek seolah-olah diambil dari posisi yang 

berlawanan dengan arah datangnya sinar, sehingga terkesan seperti bayangan. 

 

b. Gambar Ilustrasi Digital 

Ilustrasi digital adalah ilmu yang mempelajari tentang bagaimana 

mengesplorasikan kemampuan kreatif program komputer untuk membuat seni visual 

berupa ilustrasi dan memperbaiki ilustrasi. Sebelum mempelajari program aplikasi 

komputer ini, kita perlu mengenal jenis gambar digital yang akan diolah. Ada dua 

macam gambar dapat dihasilkan proses digital, yaitu gambar vektor dan gambar 

bitmap. Masing masing mempunyai karakteristik dan manfaat yang berbeda. 

Gambar vektor adalah gambar yang tidak tergantung pada resolusi. Gambar 

bitmap adalah gambar yang dibentuk oleh sekumpulan titik yang disebut pixel (picture 

element). 

Pembuatan ilustrasi digital juga dapat menggunakan foto, baik yang diedit 

terlebih dahulu menggunakan program komputer, maupun langsung digunakan tanpa 

melalui proses editing. Untuk pembuatan ilustrasi menggunakan foto tanpa melalui 

proses editing, diperlukan pengaturan lingkungan untuk pembuatan foto tersebut, 

sehingga hasilnya sesuai dengan yang diinginkan. 
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c. Gambar Ilustrasi Manual dan Digital 

Gambar ilustrasi manual dan digital adalah gambar ilustrasi yang dibuat dengan 

cara memadukan antara teknik manual dan digital. Berikut ini beberapa tahapan untuk 

membuat gambar ilustrasi manual dan digital. 

• Membuat Sketsa 

Dalam pembuatan ilustrasi, langkah awal yang harus dilakukan adalah membuat 

sketsa pada kertas putih, sesuai dengan konsep dan ide yang akandivisualisasikan. 

Sketsa dapat dibuat dengan menggunakan pensil, spidol, atau alatgambar lain yang 

dapat memunculkan warna. Setelah sketsa manual selesai dibuat langkah 

selanjutnya adalah discan dan disimpan kedalam hardisk komputer. 

• Menampilkan Sketsa Pada Komputer 

Untuk memudahkan pekerjaan menggambar dengan komputer, sketsa yang 

sudahdiscan ditampilkan pada layar monitor untuk dijadikan pola gambar. 

Menggambar digital dengan aplikasi pengolah gambar (macromedia flash, corel 

draw) Setelah gambar sketsa ada dilayar monitor, maka pembuatan sketsa digital 

dapatdimulai. Untuk yang sudah mahir dengan program corel draw maka gambar 

sketsamanual bisa dijadikan acuan. Untuk yang belum mahir maka gambar sketsa 

manualbisa dijadikan pola pembuatan sketsa digital. 

• Mewarna Ilustrasi 

Setelah sketsa selesai dibuat menggunakan aplikasi komputer, selanjutnya adalah 

mewarnai gambar tersebut. 

• Membuat Detail Ilustrasi 

Agar ilustrasi yang kita buat lebih sempurna maka kita perlu mengolah lagibagian 

demi bagian dari ilustrasi yang sudah diwarna. 

 

 

B. Evaluasi 

1. Jelaskan manfaat dari gambar sketsa! 

2. Sebutkan tiga macam peralatan untuk membuat gambar sketsa! 

3. Bacalah cerita pendek berikut dengan seksama sebelum mengerjakan tugas. 
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Buah Nangka yang Hilang 

Oleh : Rahap Ganendra 

 

Riuh rendah suara anak-anak ramai di halaman rumah Mbah Gino. Halaman yang cukup 

luas itu memang setiap harinya dipakai untuk ngumpul anak-anak tetangga. Ada yang 

bermain lompat tali, ada juga yang bermain bola plastik dan lain-lain. Namun yang lebih 

menyenangkan mereka adalah karena sering didongengin cerita-cerita lucu dan menarik. 

Mbah Gino paling jago kalo lagi dongeng. 

 

“Mbah jadi bikin kolaknya?” Tanya Lastri, cucu perempuan Mbah Gino yang tiba-tiba 

menyembulkan kepala di dapur. Lastri menemani tinggal di rumah itu, sejak suami Mbah 

Gino meninggal 4 tahun lalu. Rumah orangtua Lastri berdampingan dengan rumah Mbah 

Gino. 

 

“Iya jadi Nduk, khan mbah udah janji. Nanti ajak teman-teman lainnya ya,” jawab mbah 

Gino sambil membelah sebuah nangka matang untuk bahan kolak, menjadi dua bagian. 

Nangka hasil memetik di pohon belakang rumah kemarin. 

 

“Njiih mbah,” Lastri kegirangan lalu berlari, kembali bermain dengan teman-temannya. 

 

Mbah Gino lalu kembali sibuk menyiapkan bahan lainnya. Ada pisang, nangka, singkong 

dan lain-lain. Beberapa bahan sudah diiris-iris. Semua bahan sudah lengkap, namun ada 

satu yang belum ada. 

 

“Hmmm, santan belum ada,” gumam mbah Gino sendirian. Bergegas ia pergi ke rumah 

anaknya, yakni orangtua Lastri disebelah rumah. Dia bermaksud minta tolong Bapaknya 

Lastri untuk memetik kelapa dua buah. *** 

 

Nangka itu tinggal separoh. Mbah Gino kebingungan. Ia melihat kesana kemari di ruangan 

dapur yang tak seberapa besar itu. “Apa aku sudah pikun. 

 

Perasaan, nangkanya tadi kubelah jadi dua, mana yang separohnya ya? Masak sih hilang.” 

 

Mbah Gino resah. Bukan soal nangkanya hilang, toh masih ada sisanya yang bisa dipakai 

sebagai bahan kolaknya, namun dia sedih jika ada yang mengambilnya tanpa ijin. Mencuri. 

Dia tak berani menduga buruk, bahwa ada yang mengambilnya. Terlebih lagi jika anak-

anak yang bermain di halaman itu. “Semoga tidak dicuri.” 

*** 

Kolak satu baskom itu sudah habis. Anak-anak suka sekali nampaknya. Mereka gembira 

menikmati bersama-sama. Tak lupa mendengarkan dongengan lucu mbah Gino di sore itu. 

 

“Kami pulang dulu, besok kami main lagi kesini dan dongengin lagi yaa mbah.” Satu 

persatu anak-anak berpamitan, dan berebut mencium tangan Mbah Gino. Tatakrama, 

kebiasaaan yang biasa dilakukan di kampung terhadap orangtua. “Iyaa anak-anak. Ingat 

kalian boleh bermain tapi jangan lupa belajar.” “Njiihh mbaaaah!!” jawab mereka 

serempak. Lalu berlarian bergegas pulang. “Anton kesini dulu. Mbah mau ngomong.” 

 

Seorang anak yang dipanggil dengan nama Anton pun menghampiri Mbah Gino. 

Sementara anak-anak yang lain bergegas pulang. Anton masih kelas 3 Sekolah Dasar, 

teman Lastri, cucu Mbah Gino. Setelah Anton duduk, Mbah Gino dengan suara pelan 

bertanya. 
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“Anton, mbah Cuma mau tanya. Jawab yang jujur yaaa… apakah tadi Anton ambil buah 

nangka di dapur?” 

 

“Hmm …” Anton ragu-ragu menjawab. Ia lalu menunduk. Mbah Gino hanya tersenyum. 

 

“Gak apa-apa, Anton ga usah takut, mbah gak marah kok.” 

 

“Iiii … yyyy… aaaa mbah, Anton yang mengambilnya. Mmmaaaffin Anton mbah.” 

 

“Iya gak apa-apa. Tapi mengapa Anton lakukan? Khan bisa minta sama mbah?” 

 

“Tadi pas saya ambil minum di dapur, dan lihat nangka itu, Anton ingat adik yang di rumah. 

Kemarin saya janji kasih dia buah nangka mbah. Lalu aku ambil nangka itu, dan kukasih 

sama dia. Maafin Anton mbah. Anton salah,” jawab Anton menunduk. 

 

“Oooo… Anton, mbah senang kamu mau mengakui kesalahan. Artinya kamu tau, bahwa 

mencuri itu tidak baik. Kamu juga baik, memenuhi janji kepada adikmu, namun tidak boleh 

dengan cara yang tidak baik yaaa. Mengambil milik orang lain tanpa ijin dapat merugikan 

pada diri sendiri maupun orang yang memiliki barang itu. Orang yang mengambil akan 

berdosa, dan orang yang kehilangan barang akan sedih, susah karenanya. Lain kali saat 

menginginkan sesuatu, kita tidak boleh mengambil milik orang lain tanpa ijin yaaa,” 

nasehat Mbah Gino penuh kasih. Anton mengangguk-anggukkan kepalanya. 

 

“Yaa sudah, yang penting Anton tidak mengulanginya lagi yaaa…. Sekarang kamu boleh 

pulang,” 

 

“Iya, Mbah, Anton mengerti. Terima kasih.” 

 

Anton lalu menyalami mbah Gino dan mencium punggung telapaknya. Sesaat dia ragu-

ragu. Seperti ada yang mengganggu pikirannya. 

 

“Mbah. Bolehkah saya bertanya?” 

“Yaaa, kenapa Anton?” 

 

“Eemm…eemm… darimana Mbah tau kalo saya yang mengambil nangka itu?” 

“Heheheeeee…. ,” Mbah Gino hanya tertawa terkekeh kekeh. Anton menjadi kebingungan. 

Dia semakin penasaran. Soalnya saat mengambil nangka tadi tidak ada orang disana. Dia 

hanya sendirian. Tapi kok Mbah tau. Dia makin bingung. 

 

“Udahlah Anton, ini kamu cuci tanganmu dengan minyak ini. Tuh tanganmu lengket. 

Heheheheee,” jawab Mbah Gino sambil menyodorkan ‘jelantah’ atau minyak goreng bekas 

dalam gelas. 
 

Ooo Anton baru sadar, telapak tangannya terasa lengket, kena ‘pulut’ getah buah nangka 

tadi. 

 

Berdasarkan cerpen diatas, buatlah tiga buah sketsa untuk mengilustrasikan adegan 

yang ada dalam cerita tersebut! 
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BAB IV 

GAMBAR BENTUK DAN PERSPEKTIF 

 

3.4 Menerapkan prinsip gambar bentuk dan perspektif 

3.4.1 Menjelaskan prinsip gambar bentuk dan perspektif 

3.4.2 Menerapkan prinsip gambar bentuk dan perspektif 

4.4. Menggambar bentuk dan perspektif 

4.4.1 Menjelaskan bentuk dan perspektif 

4.4.2 Menggambar bentuk dan perspektif 

 

A. Materi 

1. Gambar Bentuk 

Menggambar bentuk adalah cara mengambar dengan meniru obyek dan 

mengutamakan kemiripan rupa. Semakin mendekati kemiripan rupa, berarti gambar bentuk 

yang dibuat semakin sempurna. Obyek gambar bentuk dapat berupa benda-benda mati, 

flora, fauna, manusia atau alam benda. 

Menggambar bentuk atau alam benda berarti menggambar berdasarkan garis dan 

bentuk dasar geometris. Macam-macam bentuk : 

• Bentuk Kubistis 

Bentuk kubistis adalah bentuk-bentuk yang menyerupai kubus atau benda yang bentuk 

dasarnya kubus. Contohnya : TV, meja, kursi, kulkas, lemari 

• Bentuk Silindris 

Bentuk silindris adalah benda yang bentuk dasarnya menyerupai silindris atau bulat. 

Contohnya : gelas, botol, bolam lampu, bola, kendi, teko, ember, guci, cangkir , kaleng 

dan piring 
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• Bentuk Bebas 

Bentuk bebas adalah benda yang bentuknya tidak beraturan atau yang tidak termasuk 

kubistis dan silindris. Contohnya : kain, buah-buahan, bunga, busana 

 

Prinsip-prinsip  seni  rupa  yang  perlu  diperhatikan  dalam  menggambar bentuk 

adalah sebagai berikut : 

• Perspektif 

Perspektif merupakan prinsip atau kaidah yang penting dalam menggambar bentuk. 

Gambar yang hendaknya sesuai dengan keadaan yang sebenarnya, yaitu gambar yang 

dekat kelihatan besar dan sebaliknya. Gambar dengan hukum perspektif berarti 

menggambar dengan pandangan satu arah atau dua titik lenyap. 
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• Proporsi 

Yang diamaksud dengan prinsip proporsi dalam menggambar bentuk adalah 

kesebandingan, keseimbangan, atau kesesuaian bentuk dan ukuran suatu benda antara 

bagian yang satu dengan yang lain. Dengan menggunakan proporsi yang tepat, maka 

gambar benda yang dihasilkan akan tampak wajar. Jika gambar yang dibuat tidak 

sesuai dengan proporsi maka akan terkesan janggal. 

• Komposisi 

Komposisi dalam menggambar bentuk dapat di artikan sebagai suatu susunan atau 

letak obyek gambar. Penyatuan komposisi obyek gambar akan lebih memperindah dan 

lebih menampakkan maksud gambar itu sendiri. 

• Gelap-terang (Half-Tone) 

Benda akan terlihat oleh mata kita bila terkena cahaya. Bagian benda yang terkena 

cahaya akantampak terang, sedang bagian benda yang tidak kena cahaya akan tampak 

gelap. 

• Bayang-bayang (shadow) 

• Dalam menggambar bentuk, peranan bayang - bayang akan sangat menentukan untuk 

terciptanya kesan tiga dimensi. Meskipun agak samar-samar, bayang-bayang harus 

ada. Dimana bayang-bayang itu sendiri dapat di bedakan menjadi tiga bagian yaitu: 

bayangan karena sinar (bayang-bayang awak ), yang berarti bayangan yang ada pada 

benda tersebut. Bayangan benda karena sinar yang mengenai benda lain ( bayang-

bayang langkah ) dan bayangan benda pada permukaan yang licin ( bayang-bayang 

sendiri ). 

Teknik menggambar bentuk ada enam, yaitu linear, blok, arsir, dusel, pointilis dan 

aquarel 

1) Linear merupakan cara menggambar obyek gambar dengan garis sebagai unsur yang 

paling menentukan, baik garis lurus atau garis lengkung. 

2) Blok merupakan cara menggambar dengan menutup obyek gambar satu warna, 

sehingga tampak bentuk globalnya (siluet). 

3) Arsir merupakan cara menggambar dengan garis-garis sejajar atau menyilang untuk 

menentukan gelap terang obyek gambar sehingga tampak seperti tiga dimensi. 

4) Dusel merupakan cara menggambar yang penentuan gelap terang obyek gambar 

menggunakan pensil gambar yang digoreskan dalam posisi miring (rebah) 
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5) Pointilis merupakan cara menggambar yang dalam menentukan gelap terang objek 

gambar menggunakan pensil atau pena gambar dengan dititik-titikkan.Teknik 

penggambaran pointilis dilakukan dengan membuat titik-titik sebanyak mungkin 

sehingga menampilkan sebuah bentuk yang diinginkan 

6) Aquarel merupakan cara menggambar dengan menggunakan cat air dengan sapuan 

warna yang tipis, sehingga hasilnya tampak transparan atau tembus pandang. 

Dalam menggambar bentuk ada dua pendekatan yang dapat digunakan yaitu: 

pendekatan dengan model dan pendekatan tanpa model. 

• Pendekatan dengan model 

Yang dimaksud dengan model adalah benda atau objek yang akan digambar, misalnya: 

kendi, gelas, buah-buahan, kursi, keramik dan sebagainya. Menggambar dengan 

pendekatan model maksudnya, dalam kegiatan menggambar harus ada model atau 

benda sesungguhnya. Dengan adanya model, penggambar lebih banyak memperoleh 

kemudahan antara lain, objek gambar lebih jelas, tidak perlu mencari-cari objek 

gambar, penggambar dapat mengontrol gambar dan model sesering mungkin, 

ketepatan sudut gambar lebih terjamin 

• Pendekatan tanpa model 

Pendekatan ini bertolak belakang dari pendekatan dengan model. Menggambar bentuk 

tanpa model banyak kekurangannya, terutama bagi siswa yang masih belajar 

menggambar. Bagi yang belum mahir, model digunakan untuk menghasilkan gambar 

yang baik, sebab tutntutan keberhasilan dalam menggambar bentuk adalah ketepatan 

gambar dengan objek yang digambar. 

a. Teknik Linear 

Teknik linear dalam membuat gambar bentuk merupakan cara menggambar objek 

dengan garis sebagai unsur yang paling menentukan. 
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b. Teknik Blok 

Teknik blok dalam membuat gambar bentuk merupakan cara menggambar obyek 

dengan memenuhi warna ke benda yang dijadikan model. 

 

c. Teknik Arsir 

Teknik arsir merupakan cara menggambar dengan garis-garis sejajar atau menyilang 

untuk menentukan gelap terang obyek gambar sehingga tampak seperti tiga dimensi. 
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d. Teknik Dusel 

Teknik dusel merupakan cara menggambar yang penentuan gelap terang obyek gambar 

menggunakan pensil gambar yang digoreskan dalam posisi miring (rebah) 

e. Teknik Pointilis 

Teknik Pointilis merupakan cara menggambar yang dalam menentukan gelap terang 

objek gambar menggunakan pensil atau pena gambar dengan dititik-titikkan.Teknik 

penggambaran pointilis dilakukan dengan membuat titik-titik sebanyak mungkin 

sehingga menampilkan sebuah bentuk yang diinginkan 

f. Teknik Aquarel 
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Teknik aquarel merupakan cara menggambar dengan menggunakan cat air dengan 

sapuan warna yang tipis, sehingga hasilnya tampak transparan atau tembus pandang. 

 

2. Gambar Perspektif 

Perspektif atau sudut pandang adalah teknik atau metode untuk menggambar 

objek-objek berupa benda, ruang (interior), dan lingkungan (eksterior) yang ukurannya 

lebih besar dari manusia. Teknik ini ada karena keterbatasan jarak pandang mata kita dalam 

melihat objek. Semakin jauh jarak mata dengan benda, semakin kecil penampakannya dan 

bahkan akan hilang dari pandangan jarak tertentu. Sebaliknya, semakin dekat jarak pandang 

mata kita, benda tersebut akan semakin terlihat besar. Dua hal yang harus dijadikan patokan 

dalam teknik menggambarperspektif sebagai berikut: 

• Titik hilang yaitu titik terjauh dari jangkauan. Jarak pandang mata dan titik hilang 

selalu terletak di dalam garis horizon. 

• Garis horizon yaitu garis khayal mata (tidak nyata). Di mana kita berada, di situlah 

garis horizon berada.  

 

• Perspektif Satu Titik Hilang  

Pada dasarnya, perspektif satu titik hilang, dua titik hilang, dan tiga titik hilang 

bisa dibagi lagi menjadi berbagai sudut pandang berdasarkan posisi mata kita berada. 

Lebih sederhanya, sudut pandang bisa dibagi 3 macam sudut pandang, yaitu sudut 

pandang mata burung, sudut pandang normal, dan sudut pandang mata kucing. 

1) Sudut Pandang Mata Burung 

Pada sudut pandang mata burung ini, mata kita seolah-olah berada diatas dan 

melihat objek yang berada di bawah. Jadi, letak garis horiszon berada di atas 

bidang gambar. Sementara itu, letak letak titik hilang berada pada garis tersebut, 

bisa dibagian kiri, tengah, atau sebelah kanan. Bahkan bisa juga diletakkan di luar 

bidang gambar. Setiap objek yang digambar, garisnya bersumber dari titik hilang. 
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Contoh gambar sederhana 

 

 

 

Contoh gambar benda 

 

Tahapan dalam menggambar : 

• Buatlah garis horizon di bagian atas bidang gambar. 

• Letakkan titik hilang di dalam garis horizon. Letak garis titik hilang bisa di 

manapun, di pinggir/ di tengah bidang gambar. 

• Buatlah garis batas ruangan/ dinding dengan patokan garis berasal dari titik 

hilang tersebut. 

• Gambarlah beberapa bangun dasar yang juga berpatokan pada garis dari titik 

hilang tersebut. Menggambarnya harus dengan perencanaan. Karena abngun 

dasar ini dijadikan gambar objek benda. 

• Gambarlah seluruh detail benda dengan patokan komposisi pada bangun 

dasar. 

• Gambarlah seluruh detail benda dengan patokan komposisi pada bangun 

dasar. 

• Arsirlah seperlunya untuk memberikan kesan tiga dimensi, volume, dan 

karakter benda. 

 

2) Sudut Pandang Normal 

Pada sudut pandang normal, diri kita seolah-olah berdiri normal memandang lurus 

kedepan. Dengan demikian, bagian atas dan bagian bawah terlihat lebih seimbang. 

Letak garis horizon tepat di tengah-tengah bidang gambar dan titik hilang bisa 

http://3.bp.blogspot.com/-TpO4Zp_8deI/Tykbg3zRqOI/AAAAAAAAABM/aF1b-vouu8g/s1600/Untitled-1+copy.jpg
http://1.bp.blogspot.com/-_vYybj_9JJg/TykaMwW1MYI/AAAAAAAAAAM/LkZu2aEC9NU/s1600/benda+sudut+mata+burung+1+..jpg
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diletakkan di mana saja pada garis tersebut. Semua objek yang digambar garisnya 

berasal dari titik hilang. 

Contoh gambar bangun sederhana 

Contoh gambar benda 

 

3) Sudut Pandang Mata Kucing 

Pada sudut pandang mata kucing, seolah-olah kita berada di posisi tiarap dan 

melihat ke depan,sehingga objek bagian atas akan lebih dominan. Letak garis 

horizon di bagian bawah bidang gambar dan letak titik hilang pada garis horizon. 

Titik hilang ini dijadikan pusat untuk menarik garis dalam menggambarkan setiap 

objek benda. 

Contoh bangun sederhana 

http://1.bp.blogspot.com/-KS6XAIxeXlU/TykbJdSMvJI/AAAAAAAAAA8/mZJCtcsVYIk/s1600/P17-09-11_15-26[1]+copy.jpg
http://4.bp.blogspot.com/-bTZFVGx0-C8/TykaWWzx1LI/AAAAAAAAAAU/BFTLlpOLp0s/s1600/benda+sudut+pandang+normal+1+.jpg


 
 

72 | SR 

Contoh gambar benda 

 

• Perspektif Dua Titik Hilang 

   Secara teknis, perspektif dengan 2 titik lenyap hampir sama dengan teknik 

perspektif 1 titik lenyap. Pada teknik perspektif 2 titik hilang, pada garis horizon 

terdapat 2 titik fokus. Persimpangan garis yang berasal dari 2 titik hilang ini akan 

membentuk sebuah sudut. Biasanya, jika jarak antara 2 titik hilang ini terlalu dekat, 

penampakan objek gambar benda mengalami distorsi. 

Tahapan untuk menggambar teknik perspektif 2 titik hilang juga hampir sama 

dengan teknik perspektif 1 titik hilang, yaitu sebagai berikut : 

• Buatlah garis horizon. Jika memakai sudut pandang mata burung, garis horizon 

berada di atas bidang gambar. Jika memakai sudut pandang normal, garis horizon 

berada di tengah-tengah bidang gambar. Jika memakai sudut pandang mata 

kucing, garis horizon berada dibagian bawah garis horizon.  

• Letakkan 2 titik, masing-masing di bagian ujung kiri dan kanan bidang gambar. 

• Jika menggambar ruangan, buatlah batas ruangan itu dengan menarik garis dari 

kedua titik tersebut. 

 

 

http://3.bp.blogspot.com/-ZWnMRmHhZW0/TykbtWB3X7I/AAAAAAAAABU/oHUlJumkSfo/s1600/Untitled-1+copym.jpg
http://2.bp.blogspot.com/-JPacfO2AlPc/TyqUviuYkQI/AAAAAAAAADo/3pol4FUDGDE/s1600/mata+meong+1.+lenyap.jpg
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• Gambarlah beberapa bangun dasar dengan patokan dari kedua titik hilangnya. 

Bangun dasar tersebut diletakkan dan dikomposisikan sesuai dengan perencanaan 

gambar yang dibuat. 

• Gambarlah seluruh detail benda dengan berpatokan pada bangun dasar yang sudah 

dibuat. Perhatikan proporsi dan perbandingan antara benda yang satu dan benda 

yang lainnya. 

• Arsirlah seperlunya untuk memberikan kesan tiga dimensi, volume, dan karakter 

benda.  

 

1) Sudut Pandang Mata Burung  

Contoh gambar bangun sederhana 

Contoh gambar benda 

2) Sudut Pandang Normal 

Contoh gambar bangun sederhana 

Contoh gambar benda 

http://2.bp.blogspot.com/-FtN9HRusYUA/Tykop0ABO2I/AAAAAAAAABk/hkJ7KDa2zYQ/s1600/P18-09-11_12-43[2].jpg
http://4.bp.blogspot.com/-Iq_9lm6Jj9M/TypB-NJHe-I/AAAAAAAAAC4/WJnnuUJ9DxQ/s1600/P18-09-11_12-43[3].jpg
http://3.bp.blogspot.com/-oELkrKWmCD0/TykqpeY3hdI/AAAAAAAAAB8/9fQg_s1NoEw/s1600/P18-09-11_12-44.jpg
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3) Sudut Pandang Mata Kucing 

Contoh gambar bangun sederhana 

 

Contoh gambar benda 

 

• Perspektif Tiga Titik Hilang 

     Perspektif dengan tiga titik hilang biasanya hanya bisa dipakai untuk 

menggambarkan sesuatu yang sangat luas, besar, tinggi, dan secara visual mengalami 

distorsi yang sangat ekstrem. Biasanya teknik ini dipakai untuk menggambar outdoor 

dan sudut pandang dari udara, meskipun bisa juga dipakai untuk sudut pandang dari 

bawah atau sudut pandang mata kucing. Agar tidak mengalami distorsi yang 

berlebihan, sebaiknya titik hilang diletakkan jauh diluar bidang gambar. 

 

 

 

http://2.bp.blogspot.com/-iaecxAR0Pj0/TykpRdppA8I/AAAAAAAAAB0/Mp73Gncrm50/s1600/P17-09-11_15-30[3].jpg
http://2.bp.blogspot.com/-WMYUoWtXgBY/TypDMMe4RKI/AAAAAAAAADI/wqHY2DXsITo/s1600/P18-09-11_12-44[2].jpg
http://1.bp.blogspot.com/-O5fsm-UTgJ8/Tykays1-JgI/AAAAAAAAAAs/20IndEMy1xw/s1600/mata+kucing+benda+2+.+hilang.jpg
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1. Sudut Pandang Mata Burung atau Penglihatan dari Atas 

Contoh gambar sederhana 

 

Contoh gambar perspektif tiga titik hilang dengan sudut pandang dari udara 

 

2. Sudut Pandang Mata Kucing 

Contoh gambar bangun sederhana 

 

 

http://1.bp.blogspot.com/-VMTzPtQsVBg/TykagNYaLfI/AAAAAAAAAAc/y2Q1ctn2dDA/s1600/mata+burung+3+.+bangun.jpg
http://1.bp.blogspot.com/-KDm8FtMrqgk/TypERFgTnHI/AAAAAAAAADQ/RLw-sFMbNjA/s1600/pandang+mata+kucing+3+.+benda+.jpg
http://1.bp.blogspot.com/-EY4FJhCWH_I/TypE-ipQe0I/AAAAAAAAADY/W2RPTJc8scY/s1600/mata+kucing+bangun+3+.+hilang.jpg
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Contoh gambar perspektif tiga titik hilang dengan sudut pandang dari bawah/ mata 

kucing 

 

 

B. Evaluasi 

1. Jelaskan macam-macam bentuk benda! 

2. Sebutkan masing-masing tiga buah media kering dan media basah yang digunakan untuk 

menggambar bentuk! 

3. Sebut dan jelaskan tiga macam teknik untuk membuat gambar bentuk! 

4. Apa yang dimaksud dengan gambar perspektif? 

5. Jelaskan macam-macam sudut pandang dalam pembuatan gambar perspektif! 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://2.bp.blogspot.com/-DyimZnZ2bcc/TypF0GvJi_I/AAAAAAAAADg/nyFhY4oxWrU/s1600/P17-09-11_15-33.jpg
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BAB V 

PENGGABUNGAN GAMBAR DAN TEKS BERBASIS VECTOR 

 

3.5 Menerapkan penggabungan gambar dan teks yang berbasis vector 

3.5.1 Menjelaskan penggabungan gambar dan teks yang berbasis vector 

3.5.2 Menerapkan penggabungan gambar dan teks yang berbasis vector 

4.5. Menggabungkan gambar dan teks yang berbasis vektor 

4.5.1 Menjelaskan gambar dan teks yang berbasis vector 

4.5.2 Menggabungkan gambar dan teks yang berbasis vector 

 

A. Materi 

Citra vektor adalah gambar yang dibuat dari unsur garis dan kurva yang disebut vektor. 

Kumpulan dari beberapa garis dan kurva ini akan membentuk suatu obyek atau gambar. Citra 

vektor merepresentasikan gambarnya tidak dengan menggunakan pixel, melaikan dengan 

kurva dan garis yang didefinisikan dalam persamaan matematis. Persamaan matematis 

tersebut disebut dengan vektor. Sebagai contoh menggambar segitiga maka didefinisikan 

persamaan matematis dari segitiga sehingga membentuk garis pembatas segitiga didalam garis 

pembatas tersebut diberi warna sehingga terbentuklah bidang segitiga. 

Beberapa format file citra vektor di antaranya: svg, eps, wmf , cdr dan lain 

sebagainya.Gambar vektor tidak tergantung pada resolusi. Citra vektor dapat diperbesar atau 

diperkecil ukuran gambar tanpa kehilangan detail gambarnya. Disamping itu gambar vektor 

akan mempunyai ukuran file yang lebih kecil dan dapat diperbesar atau diperkecil bentuknya 

tanpa merubah ukuran filenya. 

Citra vektor dapat diolah dalam format 2 dimensi maupun 3 dimensi. Aplikasi 

pengolah citra vektor 2 dimensi di antara lain corel draw, adobe ilustrator, freehand, 

macromedia flash, Xara Extreme. Sedangkan aplikasi citra vektor yang diolah dalam format 

3 dimensi diantaranya Maya 3D, Strata 3D CX, Ulead COOL 3D, Swift 3D, AutoCad, 3D 

Home Architect, google sketchup dan lain sebagainya. 

Satu satu aplikasi pengolah citra vektor yang banyak digunakan oleh editor grafis 

adalah CorelDraw. CorelDraw adalah editor citra/grafik vektor yang dikembangkan oleh 

Corel, sebuah perusahaan perangkat lunak yang bermarkas di Ottawa, Kanada. 

 

 

 

 

http://id.wikipedia.org/wiki/Editor_grafik_vektor
http://id.wikipedia.org/wiki/Corel
http://id.wikipedia.org/wiki/Perangkat_lunak
http://id.wikipedia.org/wiki/Ottawa
http://id.wikipedia.org/wiki/Kanada
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1. CorelDraw 

CorelDraw, pertama kali diluncurkan ada 1989. Aplikasi grafis vektor ini diterima 

luas oleh masyarakat dan pada akhirnya corel hanya focus pada pengembangan software. 

Beberapa inovasi untuk ilustrasi berbasis vektor pada CorelDraw : Note-edit tool, stroke 

before fill, mesh fill dan sebagainya. 

CorelDraw memiliki perbedaan aplikasi pengolah grafis vektor yang lainnya. 

Perbedaan tersebut diantaranya CorelDraw adalah suatu paket software grafis, bukan 

hanya sebuah editor gambar berbasis vektor. Peralatan – peralatan yang ada 

memungkinkan penggunanya untuk mengatur kontras, keseimbangn warna 

bahkanmengubah dari mode RGB (Red Green Blue) menjadi CMYK (Cyan Magenta 

Yellow). Khusus untuk gambar bitmap dapat diubah dengan Corel PhotoPaint. 

• Page Navigator 

Page Navigator merupakan sekumpulan informasi dan tombol perintah untuk pindah 

dari satu halaman (page) ke halaman lain. 

 

• Color palettes 

Fungsi dari color palattes adalah untuk memberi warna pada obyek . Warna bisa 

diberikan pada bidang objek maupun garis tepi dari obyek. 

 

• Toolbox 

Toolbox adalah bagian yang memuat tombol-tombol perintah yang digunakan untuk 

membuat dan memodifikasi objek. 

Pada toolbox terdapat berbagai peralatan untuk menggambar atau membuat 

desain. Ikon-ikon yang tampil hanyalah sebagian dari yang ada. Untuk melihat ikon-ikon 

yang tersembunyi, klik pada ikon dengan durasi waktu yang agak lama, maka akan tampil 

ikon-ikon yang tersembunyi. Adakalanya saat membuat obyek di lembar kerja urutannya 

kurang sesuai dengan yang diinginkan, oleh karena itu diperlukan untuk mengatur posisi 

dan urutan objek maksudnya adalah mengatur posisi objek dari atas hingga bawah pada 

suatu objek yang bertumpuk/bertindih. Langkah – langkah untuk mengatur posisi urutan 

objek adalah sebagai berikut : 
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• Klik Pick tool  dan pilih objek, pada contoh dibawah obyek yang akan diubah 

urutanya adalah obyek oval kecil dengan urutan paling belakang (urutan ke 3) akan 

dipindah ke depan 

 

• Pilih menu Arrange  Order  to front of page maka obyek akan bergeser menjadi 

urutan paling depan 

 

Perintah  To  Front  Of  Page  dapat  digantikan  dengan  shortcut  key Ctrl+Home 

• Untuk obyek menggeser menjadi urutan paling depan dapat pula menggunakan 

perintah Arrange  Order  To Front Of Layer atau shortcut key Shift+PgUp . 

Pada perintah Arrange  Order , selain To Front Of Page dan To Front Of Layer 

terdapat pula perintah lainnya yaitu : 

• To Back Of Page atau Ctrl+End untuk memindah objek ke urutan paling bawah. 

 

• To Back Of Layer atau Shift+PgDn untuk memindah objek ke urutan paling bawah. 
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• Forward One atau Ctrl+PgUp untuk memindah objek agar naik satu tingkat ke 

depan 

 

• Back One atau Ctrl+PgDn untuk memindah objek agar turun satu tingkat 

 

• Reserve Order untuk membalik urutan seluruh objek terpilih. 

 

• In Front Of untuk memindah objek di atas objek tertentu. Setelah memilih perintah 

ini, akandiminta untuk memilih objek acuan untuk menentukan posisi objek. Seperti 

contoh berikut, obyek yan akandigeser urutanya adalah oval kecil kuning, akan 

digeser didepan oval besar orange 
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• Behind untuk memindah objek di bawah objek tertentu. Setelah memilih perintah ini, 

kemudian akan diminta untuk memilih objek acuan untuk menentukan posisi objek. 

Obyek kotak biru akan dipindah urutanya dibelakang oval kecil kuning 

 

 

 

 

 

Menggabung objek adalah menggabung beberapa objek menjadi objek tunggal. 

Objek yang telah digabung masih dapat dipisah/dipecah kembali. Menggabung obyek 

pada CorelDraw dapat dilakukan dengan perintah Combine dan weld. Pada saat 

menggabung objek dengan Combine maka dua objek atau lebih sehingga 

membentuk sebuah objek tunggal.Sedangkan dengan bila menggunakan Weld maka 

menggabungkan beberapa objek menjadi sebuah objek baru yang tidak dapat dipecah 

kembali. 

Berikut ini akan dilakukan penggabungan obyek dengan menggunakan perintah 

weld, adapun langkahnya adalah sebagai berikut : 

• Klik Pick tool dan seleksi objek-objek yang akan digabung. 

 

• Klik menu Arrange  Shaping  Weld 
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• Kemudian kedua objek tersebut akan digabung menjadi objek tunggal yang warna 

tunggal(satu warna) 

• Selain itu cara di atas, perintah weld dapat digunakan dengan jalan mengklik tombol 

Weld pada property bar. 

Penggabungan obyek menggunakan perintah combine dapat dilakukan dengan 

jalan klik menu Arrange  Combine, atau tekan Ctrl+L, atau tekan tombol Combine 

pada property bar 

 

Sehingga objek akan tergabung menjadi objek tunggal dengan perpotongan antara 

objek-objek yang digabung akan berlubang, hal ini sedikit berbeda dengan hasil 

penggabungan menggunakan weld. 

 

 

 

 

 

Memotong objek suatu proses menghilangkan sebagian objek berdasarkan objek 

pemotong, objek pemotong harus menindih di atas objek yang dipotong.Pemotongan 

sebagian obyek pada corelDraw dapat dilakukan dengan perintah trim dan simplfy. 

Memotong objek dengan Trim adalah memotong objek dengan posisi objek 

pemotong berada di atas objek yang akan dipotong. Langkah – langkah untuk memotong 

objek menggunakan perintah Trim adalah sebagai berikut : 

• Klik Pick tool  dan pilih objek yang akan digunakan untuk memotong, yaitu 

objek oval dan obyek yang akan dipotong adalah kotak 
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• Tekan Shift dan klik objek yang akan dipotong, yaitu objek kotak 

 

• Klik menu Arrange  Shaping  Trim 

 

• Atau klik tombol Trim pada property bar. 

 

Selanjutnya, pindahkan posisi objek persegi untuk melihat hasil perpotongan 

 

Selain dengan trims dapat pula dilakukan pemotongan dengan simplify.Dengan 

perintah simplify digunakan untuk memotong objek yang telah terletak di bawah objek 

lain. Jika terdapat tumpukkan objek lebih dari satu, maka objek yang posisinya di atas 

akan memotong objek yang terletak di bawahnya. Langkah untuk memotong objek 

dengan Simplify adalah sebagai berikut : 
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• Klik Pick tool   dan pilih objek yang akan dipotong. 

 

 

 

 

• Klik menu Arrange  Shaping  Simplify 

 

• Atau tekan tombol saling memotong objek yang ada di bawahnya. 

 

• Pindahkan objek-objek yang telah terpotong sehingga tampak seperti gambar berikut. 

 

Suatu objek dapat dibuat dari objek lain dengan membuat objek baru berdasarkan 

gabungan dari beberapa objek tanpa harus menghilangkan objek asli. Membuat objek dari 

objek lain dapat dilakukan dengan berbagai cara, salah satunya dengan bantuan perintah 

intersect. Perintah Intersect digunakan untuk menciptakan sebuah objek baru berdasarkan 

perpotongan beberapa objek yang terseleksi. Langkah - langkah untuk menciptakan objek 

baru menggunakan Intersect adalah sebagai berikut : 
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• Klik Pick tool  dan seleksi beberapa objek sumbernya. 

 

• Klik menu Arrange  Shaping  Intersect 

 

• Atau klik tombol intersect pada property bar. 

 

• Perpotongan antar dua objek tersebut akan membentuk objek baru yang dihasilkan 

dari irisan kedua obyek asli (kotak dan lingkaran) 

 

• Klik dan geser posisi objek hasil perpotongan ke posisi lain untuk melihat hasilnya 

 

Shape tool menggunakan fasilitas yang digunakan untuk memodifikasi bentuk 

objek, seperti : melengkungkan bentuk garis objek, menambahkan dan menghapus titik-

titik pembentuk objek, meluruskan bentuk garis objek, dan sebagainya. Pada kegiatan 

belajar ini akan di jelaskan fungsi dari tool yang terdapat pada menu shape yang lebih di 

pergunakan untuk memodifikasi objek. 
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Pada Shape Editing berisi tool-tool yang dapat anda gunakan untuk mengubah dan 

memodifikasi bentuk objek. Ketika flyouts pada shape Editing               di klik akan 

muncul pilihan tool sebagai berikut 

 

 

Untuk penggunaan shape editing sudah dibahas dalam kegiatan belajar 

sebelumnya. Berikut adalah penggunaan smudge brush untuk memodifikasi 

obyekpersegi. Buat objek persegi panjang dengan pen tool ataupun rectangle tool. 

 

Klik smudge brush . Atur ukuran brush Nip size pada property bar, misal 

1 cm. 

 

Klik tahan dan geser smudge brush dari dalam objek keluar objek. 

 

2. Kombinasi Objek 

Kombinasi atau Combine objek vector itu seperti gambar dibawah ini, maksudnya 

jika 2 atau lebih objek saling tumpang tindih apabila di Combine akan menciptakan 

bagian objek kosong. Lebih jelasnya seperti ini yang dimaksud bagian objek kosong, hasil 

Combine tersebut apabila di beri background berwarna dibelakangnya bagian objek 

kosong  tembus pandang dan terlihat background-nya, coba lihat bagian dari objek yang 

dilingkari merah. 
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Untuk mencipatakan gambar diatas kita memerlukan 2 bagian objek yaitu objek 

Grunge texture dan objek Text, seperti dibawah ini; 

a. Pertama siapkan objek Grunge texture vector. 
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b. Tekan tombol F8 klik mouse diatas Grunge texture vector dan mulai mengetik, 

misalkan ketik huruf "A", selanjutnya tekan tombol spasi untuk kembali ke Pick tool, 

tekan tombol Ctrl+A untuk menyeleksi semua objek; 

 

c. Nah ini langkah yang penting yaitu perintah Combine, setelah semua objek terseleksi 

tekantombol Combine di Property Bar atau langkah sederhana tekan tombol Ctrl+L 

di Keyboard. 
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d. Sehingga hasilnya seperti gambar dibawah ini. 

B. Evaluasi 

1. Apa yang dimaksud dengan citra vector? 

2. Jelaskan apa yang kamu ketahui tentang coreldraw! 

3. Jelaskan apa yang dimaksud dengan guidelines dan grid! 

4. Apa sajakah fungsi shape tool pada pengolahan sebuah citra vektor ? 

5. Buat dan olah obyek – obyek berikut menggunakan perintah yang telah dipelajari 

 

Keterangan Obyek setelah di olah 

 

                  Smudge brush 

 

 

 

 

 

 

                           Menggunakan shaping 
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BAB VI 

EFEK GAMBAR VECTOR 

 

3.6 Menganalisis pemberian efek pada gambar vektor 

3.6.1 Menjelaskan pemberian efek pada gambar vektor 

3.6.2 Menganalisis pemberian efek pada gambar vektor 

4.6. Mendesain  efek pada gambar vektor 

4.6.1 Menjelaskan desain  efek pada gambar vector 

4.6.2 Mendesain  efek pada gambar vector 

 

A. Materi 

• Efek Dasar Objek Pada CorelDraw 

• Membuat Efek Blend 

Efek Blend adalah efek yang mengisi ruang yang kosong dengan bentuk 3D pada dua 

objek yang telah dibuat. 

 

• Membuat Efek Countour 

Efek Countour adalah efek yang memberi bagian-bagian yang sama dengan ukuran atau 

resolusi yang sebanding didalam objek aslinya. 

• Membuat Efek Distort 

Efek Distort adalah efek yang dapat merubah bentuk objek aslinya menjadi abstrak 

dengan perintah yang kita inginkan. 
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• Membuat Efek Drop Shadow 

Efek Drop Shadow adalah efek untuk memberi sebuah bayangan pada objek yang dapat 

kita atur arah datang cahayanya. 

 

• Membuat Efek Envelope 

Efek Envelope adalah efek yang memungkinkan kita untuk menyunting objek yang telah 

kita buat, fungsi ini hampir sama dengan Shape Tool 

 

• Membuat Efek Extrude 

Efek Extrude adalah efek yang dapat membuat satu objek menjadi 3D dengan dimensi 

yang dapat kita atur sendiri. 
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• Membuat Efek Transparency 

Efek Transparency adalah efek yang merubah objek menjadi transparan. 

 

• Efek Outer Glow CorelDraw 

Siapkan gambar vector seperti gambar di bawah menggunakan pen tool atau Bezier 

tool. Ini dapat dilakukan dengan tracing. Langkah-langkah dalam membuat efek outer glow 

yaitu: 

 

• Beri warna hitam objek kurva gambar orang climbing caranya seleksi objek kemudian 

klik warna hitam di Color Palette letaknya di pojok kanan. 
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• Beri juga warna hitam pada objek kotak yang fungsinya sebagai background 

 

• Selanjutnya seleksi objek kurva gambar orang climbing, pada menu Toolbox pilih Drop 

Shadow tool dan pada Property Bar klik drop down Preset list pilih Small 

Glow, hasilnya akan berwarna gradasi putih. 

 

• Untuk mengganti warna, misalnya kita ganti warna orange pada Shadow color yang 

letaknya di Property bar 
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• Sehingga warna bayangan akan berubah menjadi orange, seperti gambar dibawah ini 

• Kita bisa memperhalus efek tersebut dengan cara break apart atau tekan Ctrl+K di 

keyboard efek Drop Shadow tersebut, kemudian 

pada menu Bitmaps pilih Convert To Bitmap, 

setelah itu masih pada menu Bitmaps > Blur > 

pilih Gaussian Blur. Atur pada slider Radius 

untuk memperhalus objek bitmap tersebut. 

 

 

 

 

 

file:///G:/SMK4/XI DGP/Modul DGP/Bahan (Hapus)/EFEK GAMBAR VECTOR/Membuat Efek Outer Glow Di CorelDRAW _ Belajar CorelDRAW_files/6.jpg
file:///G:/SMK4/XI DGP/Modul DGP/Bahan (Hapus)/EFEK GAMBAR VECTOR/Membuat Efek Outer Glow Di CorelDRAW _ Belajar CorelDRAW_files/7.jpg
file:///G:/SMK4/XI DGP/Modul DGP/Bahan (Hapus)/EFEK GAMBAR VECTOR/Membuat Efek Outer Glow Di CorelDRAW _ Belajar CorelDRAW_files/9.jpg


 
 

95 | SR 

• Hasil akhir seperti gambar dibawah ini, selesai 

 

 

• Efek Powerclip 

Untuk langkah yang pertama kita buat tulisan yang akan di masuki gambar dengan 

Text Tools. Setelah itu kita siapkan gambar dengan cara mengimport atau drag. Jika sudah 

tinggal kita proses cara memasukan gambar ke dalam tulisan dengan PowerCLIP 

• Cara-nya klik gambar masuk ke menu Object > Powerclip > Place Inside > Frame. 

Kemudian arahkan panah pada tulisan. 

 

• Jika sudah maka untuk hasil-nya bisa seperti berikut ini. 
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B. Evaluasi 

1. Jelaskan cara penggunaan efek powerclip 

2. Jelaskan apa yang kamu ketahui tentang efek outer glow 

3. Apa yang dimaksud dengan efek envelope? 

4. Jelaskan cara penggunaan efek contour! 

5. Carilah tentang 3D Perspektive effect pada coreldraw  
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BAB VII 

PENGGABUNGAN GAMBAR DAN TEKS BERBASIS BITMAP 

 

3.7 Menganalisis penggabungan gambar dan teks yang berbasis bitmap 

3.7.1 Menjelaskan penggabungan gambar dan teks yang berbasis bitmap 

3.7.2 Menganalisis penggabungan gambar dan teks yang berbasis bitmap 

4.7. Menggabungkan gambar dan teks yang berbasis bitmap 

4.7.1 Membuat gambar dan teks yang berbasis bitmap 

4.7.2 Menggabungkan gambar dan teks yang berbasis bitmap 

 

A. Materi 

1. Photoshop 

Photoshop adalah salah satu perangkat lunak yang dikhususkan untuk pengeditan 

foto/gambar dan pembuatan efek, yang sangat baik untuk membuat desain grafis dalam 

bentuk bitmap. Photoshop menyediakan tool-tool yang terintegrasi dan tertata secara 

praktis untuk menciptakan dan menghasilkan karya dalam bentuk vektor dan teks. Bentuk 

grafik yang berdasarkan vektor dan teks bisa ditransfer menjadi image yang berdasarkan 

pixel untuk mendapatkan efek desain yang lebih sempurna. Secara garis besar, area kerja 

default photoshop CS3 terbagi terbagi menjadi beberapa komponen utama yaitu sebagai 

berikut : 
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• Title Bar adalah jendela yang berisi informasi program yang sedang dijalankan. Tittle 

Bar dapat dipindahkan dengan cara meng-kliknya dua kali dan menggesernya ke 

posisi yang diinginkan. 

• Menu Bar berisi perintah utama seperti membuka file, menyimpan file, mengubah 

ukuran gambar, filter dan lain-lain. 

 

• Option Bar berisi pilihan pengaturan dari tool yang dipilih. Setiap tool mempunyai 

tool option yang berbeda-beda. Misalnya dipilih brush, maka ukuran/diameter juga 

opacity brush ada disini. 

 

• Active Image Area menampilkan gambar yang sedang dikerjakan. 

• Tool Box berisi berbagai macam tool atau alat-alat yang digunakan untuk mengedit, 

atau membuat sebuah karya grafis. Tool tersebut memiliki kelompok tersendiri 

tergantung dari fungsi dan kegunaannya. Segitiga kecil yang terdapat disebelah tool, 

berarti tool tersebut memiliki sub tool. Tool tersebut memiliki perbedaan bentuk 

tetapi memiliki fungsi yang hampir sama. 

• Palet berisi tentang informasi mengenai image atau gambar yang dikerjakan, yang 

mencakup Layer , History, Navigator, Color dan lain sebagainya. Palet dapat 

ditampilkan atau disembunyikan dengan membuka menu Windows dan klik pada 

pallet yang akan ditampilkan atau disembunyikan 

• Layer. Layer adalah lapisan transparan yang saling bertumpuk antara satu lapisan 

dengan lapisan yang lain sehingga membentuk sebuah gambar baru. Setiap layer 

mempunyai objek-objek sendiri sehingga meskipun terlihat saling bertumpuk, tetapi 

objek-objeknya tidak mengganggu satu sama lain.. 

 

 

 

 

 

 

 

 



 
 

99 | SR 

Untuk dapat merubah atau menambah objek dengan memakai palet layer cukup 

dengan tekan Add a layer style, Add layer mask,create a new set, create new fill or 

adjustment layer,create a new layer dan delete layer. 

2. Gabung Multilayer 

Layer merupakan bagian pada aplikasi pengolah gambar bitmap yang digunakan 

untuk menggabungkan beberapa gambar menjadi satu gambar. 

Layer digunakan untuk menggabungkan beberapa gambar menjadi satu gambar. 

Setiap gambar diletakkan dalam satu lapisan layer dan digabungkan dengan lapisan 

lapisan layer yang lain sehingga membentuk gambar. Lapisan tersebut saling bertumpuk 

sehingga menghasilkan sebuah gambar. 

 

Layer digunakan untuk menggabungkan beberapa gambar menjadi satu gambar, 

Bisa dikatakan saat mengabungkan gambar satu dengan yang lainya akan terbentuk lebih 

dari satu layer (multi layer). Artinya beberapa gambar tersebut seakan akan bertumpuk 

sehingga akan terlihat menjadi sebuah objek atau gambar. Gambar yang berada pada layer 

atas maka akan berada pada tumpukan yang paling atas dan bisa menutupi tumpukan 

gambar yang berada dibawahnya. 
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Langkah – langkah untuk mengabungkan gambar dengan multi layer adalah 

sebagai berikut: 

• Buat file baru pada aplikasi pengolah gambar bitmap photoshop dengan perintah file  

new (ctrl + N), kemudian akan muncul kotak sebagai berikut 

 

 

 

 

 

 

 

• Beri nilai width = 400, height = 400, background contents : background color dan 

kemudian klik OK 

• Buka file gambar yang akan digabung dengan jalan klik menu file  open (ctrl + O), 

kemudian akan terbuka kotak dialog untuk memilih file. 

• Cari file yang akan digabungkan misalnya garfield1.jpg dan bart_simpson.jpg. 

• Sehingga pada lembar kerja photoshop akan terbuka 3 file 
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• Klik dan drag file bart_simpson.jpg ke file yang berisi background warna kuning, 

sehingga gambar bart_simpson akan tercopi di file ber-background kuning 

• Saat bart_simpson.jpg tergandakan difile baru maka otomatis akan terbentuk layer 

baru yang bernama layer 1. 

• Kemudian klik dan drag file garfield1.jpg ke file yang berisi background warna 

kuning, sehingga gambar garfield1.jpg akan tercopi di file ber-background kuning 

 

 

 

 

 

 

 

 

• Klik horizontal type tool    dan ketikan teks untuk judul gambar , misalnya the 

simpson & garfield. 

• Maka akan muncul teks “the simpson & garfield” pada gambar gabungan dan secara 

otomatis akan muncul layer 

baru sehingga total layer 

yang terbentuk adalah 4. 
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3. Selection Tool 

Untuk menggabungkan gambar banyak jalan yang dapat dilakukan. Teknik yang 

sering digunakan diantaranya adalah memilih/menseleksi gambar tertentu dengan teknik 

selection setelah itu menggabungkan dengan gambar yang lain sehingga menjadi desain 

gambar sesuai yang dibutuhkan. Pada aplikasi pengolah gambar bitmap disediakan 

beberapa teknik dan perangkat seleksi yang mudah untuk digunakan, diantaranya adalah 

menggunakan magic wand, lasso tool, marque tool. 

Saat akan desain ataupun menggabung gambar adakalanya gambar yang akan di 

olah hanya seb agian dari gambar tersebut sehingga sebagian darigambar tersebut harus 

diseleksi terlebih dahulu untuk kemudian baru digabung dengan gambar yang lain. 

Berikut adalah contoh penggabungan gambar bitmap yang sebelumnya menggunakan 

pemilihan bagian gambar dengan teknik seleksi. 

• Seleksi untuk gambar yang akan digandakan, gunakan salah satu teknik seleksi yang 

ada misalnya dengan lasso tool  

 

 

 

 

 

 

 

 

 

• Lalu buka file gambar yang akan ditempel oleh gambar yang telah diseleksi tersebut. 

 

• Letakkan kedua gambar berdampingan agar pada saat mendragnya lebih mudah. 
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• Lalu drag gambar yang diseleksi dengan menggunakan move tool  menuju gambar 

yang kedua. 

• Atur posisinya agar sesuai yang diinginkan 

 

4. Layer Masking 

Layer merupakan lapisan yang tembus pandang bila bagian tersebut tidak terdapat 

obyek. Layer dapat atur disusunannya dan memberikan efek ke tiap layernya dan tidak 

saling menggangu layer satu dengan yang lainnya. Pemberian layer masking pada suatu 

layer bertujuan untuk menyembunyikan bagian tertentu dari layer. Layer masking set 

warna pada layer, bila diset warna hitam artinya untuk menyembunyikan gambar dan 

warna putih untuk menampilkan gambar. Layer Mask menutup Layer. Dengan layer dapat 

menutupi seluruh Layer atau hanya bagian tertentu saja. Bagian yang tertutup tentunya 

akan tidak terlihat, begitupun sebaliknya  

Untuk menggabungkan dua gambar dengan perpotongan latar belakang halus 

dapat menggunakan teknik layer masking yang dipadu dengan gradient tool. Langkah-

langkah penggabungan gambar dengan layer masking dan gradient tool dapat dilakukan 

sebagai berikut. 

• Siapkan 2 buah file gambar yang akan digabungkan, misalnya gambar gedung berlatar 

awan biru dan gambar awan sore hari 
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• Pindahkan gambar B ke file gambar A dengan jalan klik dan drag gambar B ke file 

gambar A. 

 

 

 

 

 

 

 

 

 

• Kemudian atur ukuran gambar B agar sesuai dengan komposisi gambar A, untuk 

mengubah ukuran gambar B dapat menggunakan perintah edit free transform. 

• Pastikan foreground color berwarna hitam. 

• Pastikan layer gambar B aktif, kemudian klik “add vektor mask”. 

• Klik gradient tool  kemudian arahkan ke gambar yang akan digabung, tarik garis 

dari bawah ke atas 
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• Setelah itu akan menghasilkan penggabungan gambar seperti dibawah ini. 

 

5. Quick Masking 

Saat menggunakan tool quick masking dapat dipadukan dengan tool photoshop 

yang lainnya, misal gradient tool, brush tool, layer masking dan lain sebagainya. Fasilitas 

quick masking terdapat dideretan tool bar. Untuk mengaktifkan quick mask dengan 

menekan tombol Q pada keyboard atau memilih tool Quick Mask Mode. 

 

Prinsip kerja dari quick mask menggunakan channel secara live tanpa harus 

memilih layer pada panel pallete dari channel tersebut. Untuk membantu proses masking 

dapat menggunakan tool selection serta brush. Pada mode quick mask terdapat bahwa 

bagian yang tidak dipilih akan terbungkus lapisan berwarna merah, istilahnya rubylith. 

Untuk menutup gambar dengan rubylith dan klik mode quick mask pada tool box 

kemudian tekan ALT+Del. 
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Proses kerjanya seluruh bagian berwarna merah adalah bagian yang tidak 

terseleksi, untuk memberi warna menjadi merah atau sebaliknya kita akan menggunakan 

brush tool. Seleksi Quick mask bertumpu pada penggunaan brush, sehingga harus 

cermat menggunakan brush tool sesuai dengan kondisi gambar yang akan diseleksi, jika 

gambar dengan detail tinggi maka sebaiknya gunakan brush dengan hardness tinggi. Pada 

penerapan quick mask dengan bantuan tool brush akan menggabungkan 2 gambar, dimana 

gambar A akan disembunyikan backgroundnya dan digantikan background gambar B. 

• Buka  2 file gambar yang akan digabungkan 

 

• Langkah berikutnya  masking  bagian gambar  A dengan jalan klik  tool quick masking 

atau tekan “Q”. 

• Set foreground berwarna hitam. 
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• Klik tool brush  dan sesuaiankan diameter dari tool brush, dalam percobaan ini 

menggunakan diameter 77 – 53 – 30. Dan hardness sebesar 0%. 

 

• Arahkan brush ke area background gambar A yang akan disembunyikan, yang 

ditandai dengan munculnya rubylith pada gambar. 

 

• Setelah selesai untuk memasking (yang akan disembunyikan berwarna merah) , klik 

“edit in standard mode mode” untuk menghilangkan ara rubylith 
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• Klik drag area yang terseleksi pada gambar A ke gambar B 

 

• Kemudian sesuaikan ukuran dan posisi obyek gambar A dengan menggunakan “free 

transform” agar sesuai dengan background dan akan menghasilkan gambar seperti 

dibawah ini. 

 

 

 

 

 

 

 

 

 

B. Evaluasi 

1. Sebutkan komponen utama area kerja dalam Photoshop CS3, dan jelaskan fungsinya. 

2. Apa saja Option Bar yang tampil ketika memilih tool Type? Sebut dan jelaskan. 

3. Apa yang terjadi pada sebuah gambar bitmap diubah nilai opacity pada layer dari 100% 

menjadi 30% ? 

4. Apa yang menjadi pertimbangan untuk memilih selection tool yang akan digunakan proses 

menggabungkan gambar bitmap\ 

5. Bagaimana hasil penggunaan brush dengan foreground hitam pada suatu layer, dimana 

layer tersebut diberi perintah “Add vektor mask” 
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BAB VIII 

EFEK GAMBAR BITMAP 

 

3.8 Menganalisis pemberian efek pada gambar bitmap 

3.8.1 Menerapkan pemberian efek pada gambar bitmap 

3.8.2 Menganalisis pemberian efek pada gambar bitmap 

4.8. Mendesain efek pada gambar bitmap 

4.8.1 Menjelaskan efek pada gambar bitmap 

4.8.2 Mendesain efek pada gambar bitmap 

 

A. Materi 

1. Efek Pada Teks 

Teks merupakan objek yang secara sistematis membentuk shape huruf, simbol dan 

angka. Teks di dalam Photoshop merupakan kumpulan piksel-piksel yang mempunyai 

resolusi sama dengan file objek, sehingga bila dilakukan pembesaran objek atau zooming, 

teks akan tampak berundak (jaged) apabila melewati batas besar resolusi objek asli. Untuk 

membuat huruf atau kata, caranya berbeda dengan membuat paragraph. Huruf dibuat 

dengan klik pada objek yang aktif dan kemudian menuliskan teks yang akan dimasukkan. 

Sedangkan paragraph dapat dibuat dengan melakukan dragging terlebih dahulu untuk 

menentukan area paragraph baru, kemudian menuliskan teks yang telah didefinisikan 

tersebut. 
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Layer teks otomatis akan terbentuk saat mengklik objek yang aktif. 

 

Layer type tidak akan muncul sebagai layer baru saat menggunakan mode 

multichannel, bitmap, maupun indexed color, sebab mode ini tidak mendukung layer, 

sehingga teks hanya akan tampil pada layer background saja. 

Dalam mengatur teks. Teks dapat diatur menggunakan palet character yang dapat 

diaktifkan melalui Window > Character. 

 

Untuk mengatur paragraph teks, pilih tab Paragraph. 
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Type mask digunakan untuk membentuk seleksi dengan bentuk font yang dipilih, 

dengan orientasi horizontal maupun vertikal. Seleksi type mask ini akan ditampilkan pada 

layer yang aktif, yang dapat dipindah, disalin, diisi warna dan diberi stroke. Cara 

membuatnya adalah : 

• Pilih layer yang akan diberi type mask. 

• Pilih Type Mask Tool, baik vertikal maupun horizontal. 

• Ketikkan pada layer baru. Teks akan tampil dengan warna mask. 

• Klik pada layer palet atau klik Commit any current edits di sebelah kanan pada option 

bar untuk memunculkan marquee huruf. 

 

• Pilih layer via copy (Ctrl+J) untuk membentuk layer baru dari hasil salinan marquee 

teks tersebut. Teks tidak akan tampak karena tekstur dan fill teks sama persis dengan 

background. 

• Tambahkan layer style glow untuk memberikan kontras objek dengan latar belakang 

dengan mengklik menu Layer > Layer Style > Drop Shadow. 
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Warping adalah fasilitas untuk mendistorsi bentuk objek dengan beberapa variasi 

bentuk. Teks tersebut akan mengikuti bentuk shape yang dipilih. 

 

Cara melakukan warp adalah: 

• Pilih layer type 

• Pilih Type Tool, klik tombol Warp  

• Pilih warp style dari menu Style Pup-up. 

• Pilih orientasi warp teks, horizontal atau vertikal. 

• Tentukan beberapa option: 

Bend, digunakan untuk mengatur besar distorsi warp. 

Horizontal dan Vertikal Distortion, untuk menerapkan perspektif objek. 

• Untuk membatalkan Warp, klik None. 

 

Pada halaman web sering digunakan berbagai efek teks sehingga teks akan terlihat 

lebih indah dan menarik perhatian pengunjung. Efek teks biasanya digunakan sebagai 

logo, banner, link dan judul. Jenis-jenis efek teks antara lain : 

• Teks Melengkung 

Photoshop mempunyai fasilitas yaitu Warp Text yang di dalamnya menyediakan 

berbagai style yang bisa digunakan secara langsung untuk melengkungkan teks. 
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• Teks 3D 

 

Bentuk 3D menjadi popular dan banyak digunakan oleh para desainer untuk 

menambah keindahan desainnya. 

 

 

• Teks Lembut 

Teks lembut adalah teks yang berlatar belakang kabur, sehingga teks yang ada di 

atasnya terkesan lembut. Teks ini banyak digunakan dalam mendesain halaman web. 

• Teks Gradasi 

Teks gradasi adalah teks yang dibuat dengan menerapkan efek gradasi warna, sehingga 

perpindahan atau transisi warna pada teks terlihat secara halus. Gradasi warna bisa 

terdiri atas dua warna atau lebih. 

 

• Teks Warna Warni 

Teks warna warni adalah teks yang terdiri atas beberapa warna dalam suatu tulisan, 

antara satu huruf dengan huruf lainnya mempunyai warna yang berbeda-beda, 

sehingga menimbulkan kesan ceria, ramai dan periang. 

 

• Teks Outline Ganda 

Teks outline ganda adalah teks yang mempunyai dua garis pinggir dengan 

menggunakan warna garis pinggir yang berbeda antara garis yang satu dengan yang 

lain, sehingga terlihat seperti tiga buah teks dalam satu tulisan. 
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• Teks Menyala 

Teks menyala adalah efek yang menambah pencahayaan atau sinar yang memudar 

secara bertahap di luar sisi teks, sehingga teks akan terlihat menyala seperti api lilin. 

 

• Teks Garis Bersusun 

Teks garis bersusun adalah teks yang menggunakan pola garis-garis lurus bersusun 

secara horizontal sebagai motifnya, sehingga teks akan terlihat lebih elegan. Teks ini 

banyak digunakan untuk membuat logo suatu perusahaan atau produk. 

 

• Teks Berkarat 

Teks berkarat adalah teks yang dibuat dengan menerapkan efek seperti besi yang sudah 

karatan karena sudah dimakan usia alias using. 

 

• Teks Emas 

Teks emas adalah teks yang dibuat dengan menerapkan efek kuning keemasan yang 

terlihat mengkilap gemerlapan pada teks, sehingga menimbulkan kesan mewah. 
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• Teks Aqua 

Teks aqua adalah teks yang menggunakan efek seperti kaca bening pada galon plastik 

minuman aqua dengan pendaran cahaya berwarna kebiru-biruan. 

• Teks Bertabur Perak 

Teks bertabur perak adalah teks yang menggunakan efek berupa taburan perak di atas 

permukaan teks. 

 

• Teks Api 

Teks api adalah teks yang menggunakan efek seperti api yang mengelilingi teks 

tersebut. 

 

• Efek Ice 

Teks efek ice adalah teks yang memberikan kesan seperti terbungkus es. 

 

2. Filter 

Filter adalah fasilitas yang disediakan oleh aplikasi pengolah gambar bitmap 

photoshop untuk memberikan efek tertentu pada obyek gambar bitmap sehingga desain 

gambar yang dihasilkan akan lebih hidup . Dengan adanya efek dari filter desain gambar 

bitmap yang dibuat akan menjadi special.  
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Cukup banyak filter yang disediakan oleh aplikasi pengolah gambar bitmap 

photoshop jumlahnya mencapai ratusan buah , sehingga pada kegiatan belajar ini tidak 

akan dibahas semuanya secara detail, namun akan diajarkan secara garis besarnya serta 

cara pemakaian fasilitas filter. Filter yang ada dalam dapat ditambah lagi macamnya 

dengan jalan menambahkan plug-ins filter. Plugin filter bisa didapatkan dengan cara 

mendownload, mengkopi atau membeli, seperti perintah digimarc yang terdapat di menu 

filter. Tiap - tiap filter mempunyai option untuk mengatur hasilnya sesuai agar sesuai 

dengan keinginan desainer grafis. Pada saat memilih salah satu filter maka akan muncul 

kotak dialog untuk mengatur parameter – parameter filter lebih lanjut sehingga nantinya 

akan didapatkan efek yang sesuai. 

Untuk dapat mengaplikasikan salah satu filter maka harus dipilih dahulu bagian 

mana dari gambar yang akan diberi effect, lalu bagian tersebut diseleksi. Efek filter bisa 

diberikan ke obyek gambar bitmap maupun obyek teks. Untuk efek filter pada teks akan 

dibahas lebih lanjut pada kegiatan belajar selanjutnya. Filter secara garis besar dibagi 

menjadi 13 jenis filter. 

Cukup banyak filter yang disediakan oleh aplikasi pengolah gambar bitmap 

photoshop, dan tiap - tiap filter mempunyai option untuk mengatur hasilnya sesuai agar 

sesuai dengan keinginan desainer grafis. Untuk dapat mengaplikasikan salah satu filter 

maka harus dipilih dahulu bagian mana dari gambar yang akan diberi effect, lalu bagian 

tersebut diseleksi. Saat mengolah gambar bitmap fitur filter dapat dikombinasikan dengan 

fitur – fitur yang lainnya, misalnya selection, pewarnaan, layer mask, quick masking, 

adjusment image maupun adjusment layer dan lain sebagainya. Pada kegiatan belajar kali 

akan dipelajari bagaimana cara menerapkan filter yang dipadukan dengan fitur lainnya 

pada gambar bitmap. 

 

Penerapan filter - clipping mask – adjusment layer 

Clipping mask merupakan suatu fitur untuk membuat sebuah gambar 

menyesuaikan dengan bentuk objek yang berada di bawahnya. Clipping Mask dapat 

diberikan ke semua tipe objek diantaranya shape, gambar bitmap, maupun teks. 

 

 

 



 
 

117 | SR 

 

Untuk membuat suatu layer menjadi clipping mask tekan dapat dilakukan dengan 

menekan tombol Alt dan gerakkan kursor mouse diantara “layer 1” dan layer “clipping 

mask” sampai kursor berubah menjadi icon clipping mask. 

Pengunaan adjusment kali ini bersifat non distruktif. Pada percobaan kali ini akan 

menyajikan hasil pengolahan gambar bitmap bunga yang sebagian bungan diberi bingkai 

sehingga tampak fokus, bingkai diolah menggunakan clipping mask, obyek diluar bingkai 

akan nampak blur. Berikut ini adalah pengolahan gambar bitmap filter dan clipping mask. 

• Buka gambar bitmap yang akan di edit sebagai background layer, misal gambar 

bunga 

• Kemudian background layer (tekan ctrl+J) atau dengan cara klik kanan  pada 

layer l 

 

• Buat layer baru di bawah layer 1 dengan cara klik create new layer pada bagian bawah 

layers palette sambil menekan Ctrl sehingga otomatis akan membuat layer baru di bawah 

layer yang sedang di pilih dan beri nama clipping mask. 
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• Pilih layer clipping mask pada layer palette dan klik Rectangle tool atau tekan U pada 

keyboard. buat bentuk Rectangle pada bagian yang ingin di fokuskan 

• Langkah berikutnya me-clipping mask layer clipping mask dengan cara tekan Alt dan 

gerakkan kursor mouse diantara “layer 1” dan layer “clipping mask” sampai kursor 

berubah menjadi icon clipping mask. 

• Ketika icon clipping mask sudah muncul maka klik dengan mouse untuk membuat 

clipping mask.terlihat tidak terjadi apa-apa pada image akan tetapi pada layer palette “layer 

1” akan ada tanda indent ke kanan yang berarti telah di potong oleh vector shape di 

bawahnya. 

 

• Pastikan layer “clipping mask” masih terpilih kemudian klik pada icon layer styles pada 

bagian bawah palette dan pilih Stroke dari daftar layer styles dan atur size sesuaikan 

dengan ukuran image,position set pada Inside yang berarti border berada di dalam shape 

kemudian atur juga ganti color dengan warna putih. 
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• Tambahkan bayangan dengan menambahkan drop shadow pada blending option,atur 

angle,distance & opacity 

 

• Gunakan free transform atau tekan Ctrl+T untuk merotasi objek “clipping mask” dan 

juga menskala sesuai dengan yang di kehendaki.tekan enter jika sudah mendapatkan 

skala dan rotasi yang inginkan. 
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• Copy background layer kemudian gunakan eyedropper tool untuk mengambil sampel 

warna yang nantinya akan di gunakan untuk mewarnai layer background copy. 

 

• Pilih layer background copy kemudian klik pada New adjustment layer pada bagian 

bawah palette layer dan pilih Hue/saturation dan ketika muncul kotak dialog 

hue/saturation centang bagian colorize. 

 

• Dari hasil hue/saturation akan terlihat gambar bitmap seperti berikut: 
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• Tetap pada layer background copy tambahkan filter blur pilih blur radial,pada 

dialog box blur radial pilih zoom dan atur juga nilai amount dari radial blur. 

 

• Klik Ok untuk mengakhiri perintah dan terlihat hasil seperti gambar dibawah 

 

3. Layer Style dan Style 

Layer styles merupakan salah satu cara untuk memberikan spesial efek yang dapat 

diterapkan untuk obyek pada layer aplikasi pengolah gambar bitmap photoshop. Layer 

Styles berhubungan dengan layer content. Efek blending option pada layer dapat diubah 

- ubah layer sesuai dengan kebutuhan desain. Layer style bisa diberikan ke obyek layer, 

shape maupun obyek teks. 

Layer style secara garis besar dapat dibagi menjadi 2 yaitu style dan blending 

options. Saat menggunakan style efek tercipta lebih cepat namun sering kali efek yang 

disediakan masih kurang pas dengan yang diinginkan desainer. 

Bila ingin membuat efek yang detail sesuai dengan keinginanan dpat 

menggunakan layer style – blending option sebagai jalan keluarnya. Efek layer style-

blending options dapat bisa dibuat sendiri dengan menggunakan macam efek pilihan serta 

seting parameter. Saat layer diberi efek maka akan terlihat pada layernya 
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Styles merupakan cara cepat untuk memberikan spesial efek yang dapat 

diterapkan untuk suatu layer pada aplikasi pengolah gambar bitmap photoshop dimana 

efek-efek blending option sudah diramu tinggal digunakan di pilihan style. Bisa dikatakan 

bahwa style adalah tambahan efek yang akan diberikan terhadap suatu layer. Efek – efek 

pada style tersebut telah disediakan, tinggal memilih dan menerapkannya pada layer 

tersebut. 

Dengan menggunakan efek layer style dapat mempercantik desain sekaligus 

mempercepat pekerjaan karena style yang disediakan pada layer style tinggal di klik 

makan langsung bisa dilihar hasilnya. Pemberian efek style pada layer merupakan cara 

instan untuk mendapat efek pada layer desain. Berikut ini adalah posisi palette layar pada 

lembar kerja aplikasi pengolah gambar bitmap photoshop. 

 

Aplikasi pengolah gambar bitmap 

photoshop menyediakan banyak Layer 

Style Presets, semua efek tersebut dapat 

diakses melalui (Window  Styles). Maka 

akan muncul Palette Styles seperti pada 

gambar berikut 
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Untuk menerapkan layer mode pada aplikasi pengolah gambar bitmap ini, 

sedikitnya dibutuhkan 2 layer agar terlihat efek dari layer mode tersebut. Berikut 

adalah langkah-langkah untuk menerapkan layer mode. 

• Buat file baru yang terdiri dari minimal 2 layer. 1 layer berisi gambar bitmap dan 

1 layer diberi warna 

 

 

• Pilih layer aktif pada layer atas ganti layer mode normal dengan blend mode 

yang di inginkan 
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4. Adjustments 

Istilah adjustment  sering kali ditemukan saat membuka membaca tutorial atau 

saat mencoba tool pada aplikasi pengolah gambar bitmap. Pada dasarnya adjustment itu 

sendiri ada dua jenis penerapan, yaitu image adjustment dan layer adjustment. Fungsi dari 

image adjustment dan layer adjustment hampir sama, yaitu sama-sama untuk 

pengaturan/pengubahan warna. Namun ada hal yang paling mendasari yang membedakan 

kedua, yaitu jika layer adjustment bersifat non destruktif sedangkan image adjustment 

bersifat destruktif. 

Layer adjustment merupakan fitur yang bekerja pada layer untuk menyesuaikan 

warna gambar bitmap. Ketika melakukan editing gambar bitmap dengan Layer 

adjustment maka tidak akan merubah pixel asli dari gambar tersebut (non destruktif). Icon 

layer adjustment terdapat pada bagian bawah layer berupa lingkaran setengah hitam dan 

setengah bagian berwarna putih. Ketika icon layer adjustment diklik maka akan muncul 

pilihan layer adjustment yang dibagi 4 kelompok yang berisi 17 adjustment layer 

 

Berikut ini penerapan layer adjustment untuk sebagian area dari gambar yang 

diseleksi. Area yang klasik hitam putih menggunakan layer adjustment > detailnya 

adalah sebagai berikut. 
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• Buka gambar yang akan di beri efek adjustment memberikan  efek  pada 

diseleksi diberi nuansa black  white. Klik magnetic lasso tool untuk menyeleksi 

area yang tidak terkena efek klasik black&white 

 

 

• Arahkan magnetic lasso tool ke bagian kecambah 

 

• Klik menu select > inverse, hal ini bertujuan untuk membalik area yang 

terseleksi 
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• Klik icon adjustment > black&white maka akan muncul kotak dialog adjustment 

– black&white.  

• Atur parameter adjustment > black&white seperti pada contoh berikut 

 

• Klik OK untuk mengakhiri perintah dan akan menghasilkan perubahan tampilan 

sebagai berikut 
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B. Evaluasi 

1. Efek teks apa saja yang sering digunakan dalam web? 

2. Bagaimana proses penerapan filter sampai bisa memberikan efek pada gambar? 

3. Bandingkan antara efek inner glow dan inner shadow, apakah perbedaan keduanya ? 

4. Pada layer mode terdapat 5 group mode, jelaskan perbedaan fungsi darken mode dan 

Lighten modes! 

5. Apakah fungsi selection saat penerapan efek layer adjustment? 
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BAB IX 

DESAIN BERBASIS BITMAP DAN VECTOR 

 

3.9 Mengevaluasi Desain berbasis Bitmap dan Vector 

3.9.1 Membuat Desain berbasis Bitmap dan Vector 

3.9.2 Mengevaluasi Desain berbasis Bitmap dan Vector 

4.9. Membuat review Desain berbasis Bitmap dan Vector 

4.9.1 Menjelaskan review Desain berbasis Bitmap dan Vector 

4.9.2 Membuat review Desain berbasis Bitmap dan Vector 

 

A. Materi 

Pelbagai karya seni dapat dilihat dalam kehidupan sehari-hari , misalnya website, blog, 

kartu nama, kartu undangan, liflet, brosur, seni fotografi. Banyak pengguna komputer yang 

menciptakan sebuah website dengan desain grafis yang paling menarik untuk ditampilkan. 

Karya-karya tersebut dapat dibuat sendiri dengan menggunakan perangkat lunak grafis. 

Karena itu banyak bermunculan program-program aplikasi pembuat grafis yang mudah 

dipelajari dengan fitur-fitur yang canggih dan mudah dioperasikan. Program aplikasi pembuat 

grafis berkembang sangat cepat sejak diperkenalkannya sistem GUI (Graphical User 

Interface). GUI mudah untuk dipelajari karena menggunakan ikon atau toolbox secara visual 

sebagai pengganti menu atau perintah yang berbasis command line (teks). 

Berikut adalah langkah-langkah dalam membuat brosur dengan aplikasi photoshop. 

• Pertama, mengatur dokumen dengan ukuran yang benar dan pengaturan untuk mencetak 

Buat dokumen baru di Photoshop, atur dimensi 216x154 mm. Dimensi ini mewakili 

ukuran kertas A5 dengan 3 mm bleed ditambahkan ke setiap tepi. Karena kita akan 

membuat atwork untuk dicetak, atur Mode 

Warna dengan CMYK dan Resolusi menjadi 300 Pixel / Inch. 
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• Buat panduan baru yang akan mewakili bleed area Illustrator dan InDesign sudah 

memiliki fungsi ini didalamnya, 

tapi di Photoshop, kita harus 

membuatnya sendiri. 

Gunakan Move Tool (V) dan 

tombol Shift untuk membuat 

sebuah panduan horisontal dengan 

menyeret kursor dari penggaris 

atas. Pastikan bahwa panduan ini 

terletak 3 mm pada sumbu Y. 

• Ulangi proses yang sama untuk membuat panduan di setiap tepi dokumen Pastikan bahwa 

setiap panduan adalah inset 3 mm sama di setiap tepi. 
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• Tekan Shift-Cmd-N untuk membuat Layer baru. Isi dengan warna putihsebagai warna 

Foreground (Alt-Backspace). Pastikan bahwa Anda memiliki CMYK 

Sliders dihidupkan sehingga Anda menggunakan cetak warna 

 

• Buat Gradient Overlay baru. Dalam Layer Style Panel, edit Gradient tersebut. 

Mengatur slider putih Lokasi menjadi 30%. Mengubah warna slider hitam untuk Pale 

Yellow (C = 9 M = 6 Y 

= 14 K = 0). 
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• Tambahkan overlay gradien dari tombol fx di panel layer ... 
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• Kemudian menyesuaikan gradien Anda dengan warna yang Anda inginkan untuk 

dokumen   

 

• Gunakan Rectangle Tool (U) untuk membuat empat persegi panjang baru 

Atur ukurannya 216 mm dengan 56 mm. 
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• Sejajarkan persegi panjang ke sudut kiri atas dokumen. Isi dengan Dark Brown (C = 

49 M = 74 Y = 80 K = 70). 

 

• Gunakan Pen Tool (P) untuk menambahkan titik anchor baru di tepi bawah persegi 

panjang. 
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• Dengan Direct Selection Tool (A), mainkan pegangan anchor untuk membuat kurva 

Bezier yang bagus. 

 

• Ikuti langkah-langkah yang sama untuk menyesuaikan persegi panjang menjadi bentuk 

yang ditunjukkan di bawah. 
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• Buka File> Place Embedded ..., kemudian pilih people-1.jpg dari Resource Pack. 

 

• Gunakan Move Tool (V) untuk memindahkan foto di sekitar dokumen. Tempatkan di 

sudut paling atas seperti yang ditunjukkan di bawah ini. 
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• Buat persegi panjang baru dengan Rectangle Tool (U).  

• Atur ukurannya menjadi 216 mm dengan 100 mm. 

 

• Gunakan Direct Selection Tool (A) untuk menempatkan persegi panjang langsung di 

atas foto di sudut kiri atas. 
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• Dalam opsi Panel Rectangle Tool, pilih Mask. Ini akan membuat masker vektor dipakai 

pada layer dengan foto. 

 

• Tambahkan titik anchor baru untuk mask dengan Pen Tool (P). Buat kurva Bezier 

melengkung dengan Direct Selection Tool (A). 
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• Menggunakan alat yang sama, Pen Tool dan Direct Selection Tool, mencoba untuk 

menyesuaikan mask ke dalam bentuk yang ditunjukkan di bawah. Perhatikan posisi dari 

anchor poin dan kesederhanaan bentuk. Semakin sedikit anchor poin yang Anda gunakan, 

akan muncul mask akhir yang halus. 

 

• Buka Filter > Blur > Gaussian Blur. Atur Radius menjadi 6 
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• Pilih Smart Filters mask. Gunakan Gradient Tool (G) untuk memudarkan mask dari 

kiri ke kanan. 

• Mengatur arah gradien dari kiri ke kanan untuk mengaburkan gambar ke arah kanan 
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• Buat Layer Mask baru. Gunakan Brush Tool (B) memudarkan tangga yang ada pada 

foto. Gunakan beberapa naluri dasar dan kreativitas. 

 

• Buat Brightness / Contrast Adjustment Layer baru dengan mengklik ikon matahari 

di Adjustments panel Atur Brightness menjadi 40 dan Contrast menjadi 10. 
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• Klik kanan pada Adjustment Layer dan pilih Create Clipping Mask. Ini akan 

menggunakan pengaturan brightness baru hanya untuk foto di bawah. 

 

• Buat Solid Color baru. Atur Fill warna menjadi Coklat (C=30 M=80 Y=100 K=30). 
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• Klik pada vector mask dari layer foto. Tahan tombol Alt dan tarik mask keatas Fill 

Warna coklat. Tindakan ini akan menduplikasi mask yang dipilih. 

 

• Gunakan Direct Selection Tool (A) dan tarik anchor poin ke kanan atas menunju ke pojok 

kanan atas. 
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• Gunakan Brush Tool (B) untuk memperihatkan beberapa wilayah foto di bawah dengan 

warna coklat. Atur Layer Opocity menjadi 75% 

 

• Gambar persegi panjang baru dengan Rectangle Tool (U). 
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• Warnai persegi panjang dengan Warna Coklat Muda (C = 10 M = 65 Y = 100 K = 0). 

 

• Tempatkan layer dengan persegi panjang coklat muda di bawah persegi panjang coklat 

gelap. 
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• Gunakan Pen Tool (P) dengan Direct Selection Tool (A) untuk menyesuaikan persegi 

panjang menjadi bentuk melengkung seperti yang ditunjukkan di bawah ini. 

 

• Buat Ellipse (U) baru. Atur dimensi menjadi 248 px dengan 248 px. Warnai 

dengan warna Coklat (C=30 M=80 Y=100 K=30). 
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• Tambahkan efek Drop Shadow. Atur Opacity menjadi 14%, Distance menjadi 5 px, 

dan Size menjadi 15 px. 
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• Tambahkan drop shadow untuk layer dari tombol fx di layer panelTweak drop shadow 

Anda dengan pengaturan ini 

 

• Buat Ellipse (U) baru. Atur dimensi menjadi 400 px dengan 400 px Warnai 

dengan warna biru tua  (C=100 M=80 Y=45 K=50). 
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• Menggunakan efek Drop Shadow yang sama dan menerapkannya ke elips. Anda dapat 

menciptakan bayangan, atau klik kanan dan pilih Copy Layer Styledan kemudian paste 

layer style pada elips lain. Taruh layer dengan elips biru tua di bawah elips coklat. 

 

• Tambahkan teks dengan Type Tool (T). Tutorial ini menggunakan Proxima 

Nova family. Ukuran judul atas 17 pt. Tambahkan sisa teks, dengan masing-masing di 

lapisan yang terpisah. Gunakan Move Tool (V) untuk menempatkan pada setiap baris, 

seperti diuraikan dalam gambar di bawah ini. 

 



 
 

149 | SR 

• Ulangi proses yang sama untuk menambahkan teks baru. Atur ukuran baris pertama 

menjadi 31 pt. 

 

• Buat judul baru menggunakan Type Tool (T). Atur huruf menjadi Proxima Nova 

Light dan ukurannya menjadi 18 pt. 

 

• Tambahkan subjudul, sekali lagi, menggunakan Type Tool (T). Atur ukuran manjadi 36 

pt. Sesuaikan Character Tracking ke -10. 
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• Pilih kedua teks layers. Tahan tombol Alt dan seret teks untuk menduplikasi kedua garis 

di bawah. 

 

• Sekali lagi, gunakan Type Tool (T) untuk menulis ulang teks sesuai dengan gambar di 

bawah ini. Posisikan teks dengan Move Tool (V). 
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• Buka File> Place Embedded dan tempatkan logo vektor acme-travel-logo.ai  ke dalam 

dokumen. 

 

• Kecilkan ukuran logo vektor dan taruh di sudut kanan atas. 
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• Menambahkan efek Drop Shadow. Dalam Layer Style Panel, 

atur Opacitymenjadi 11%, Distance menjadi 3 px, dan Ukuran menjadi 16 px. 

 

• Buat Rectangle (U) baru. Atur ukuran menjadi 60 px dengan 28 px. 
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• Pilih bentuk persegi panjang dengan Direct Selection Tool (A). Pada panel align, atur 

Pusat Horizontal. 

 

• Buka File> Place Embedded dan tempatkan foto people-11.jpg dari Resource Pack. 
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• Kecilkan gambar dan tempatkan langsung pada persegi panjang. 

 

• Aktifkan Rectangle Tool (U), dan di panel pilihan, klik Mask. Tindakan ini akan 

membuat vektor mask dari persegi panjang dan menerapkannya ke foto. 
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• Dengan layer foto masih dipilih, tahan Alt-Shift dan geser foto untuk menduplikasi itu. 

 

• Buka File > Place Embedded. Pilih foto city-5.jpg dari Resource Pack dan tambahkan ke 

dalam dokumen. 
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• Kecilkan gambar dan letakkan di atas foto yang digandakan dengan gadis. 

 

• Ambil mask dari foto digandakan dengan gadis itu dan menempatkannya ke dalam gambar 

baru, kemudian hapus layer people-11-copy. 
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• Ulangi langkah 7 sampai 9 untuk menambahkan screenshot ke dalam dokumen, kali ini 

tempatkan gambar peta. 

 

• Pilih layer peta-screenshot dan menambahkan Stroke dari tombol efek di layer panel. 
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• Atur Stroke Size menjadi 2 px. Sesuaikan Position ke Inside dan 

atur Warnamenjadi Coklat (C = 30 M = 80 Y = 100 K = 30). 
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• Gunakan Type Tool (T) untuk membuat contoh baru dari teks. Atur Ukuran menjadi 11 

pt dan warna menjadi Coklat Muda (C=10 M=65 Y=100 K=0). 
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• Tambahkan lebih banyak garis. Atur ukuran menjadi 9 pt, menyesuaikan 

Leading menjadi 13 pt, dan merubah warna menjadi abu-abu (K=90). 

 

• Mengikuti proses yang sama untuk membuat blok baru dari teks. Menempatkan mereka di 

bawah foto dengan gadis dan screenshot peta. 

 

• Buka File > Place Embedded... Pilih icons.ai untuk mengimpor ikon ke dalam dokumen. 

Sebuah jendela kontekstual baru akan muncul. Pilih Calendar Icon and klik OK. 
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• Kecilkan ikon dan tempatkan ke baris pertama dengan informasi waktu. 

 

• Ulangi proses yang sama untuk mengimpor sisa ikon dan menempatkan mereka sesuai 

sebelah setiap baris. 
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• Gunakan Type Tool (T) untuk menambhkan teks baru. Letakkan di screenshot peta. 

Atur ukuran menjadi 13pt, menyesuaikan Leading menjadi 11pt, dan 

merubah warna menjadi Coklat Muda (C=10 M=65 Y=100 K=0). 

 

• Mengikuti proses yang sama untuk menambahkan baris baru teks untuk alamat. 

Atur ukuran menjadi 9 pt dan merubah warna menjadi abu-abu (K=90). 
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• Buka File > Place Embedded..., pilih icons.ai lagi dan mengimpor Globe Vector Icon ke 

dalam dokumen. 
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• Kecilkan ikon dan menempatkannya di samping alamat web. 

 

• Aktifkan Pen Tool (P) dan buat bentuk vektor yang akan mewakili arah di peta. 

 

• Dalam Options Panel, atur Stroke menjadi Dashed dan warna menjadi Coklat Muda 

(C=10 M=65 Y=100 K=0). Sesuaikan Stroke Width menjadi 1,5 pt. 
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• Buka Stroke Options > More Options..., dan atur Caps menjadi Round dan 

sesuaikan Dashed Line: Dash menjadi 3 dan Gap menjadi 3. 

 

• Buat Ellipse (U) baru. Atur warna menjadi coklat (C=30 M=80 Y=100 K=30). 
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• Aktifkan Pen Tool (P). Tahan tombol Alt dan klik pada titik anchor bawah. Ini akan 

mengubah titik anchor dari yang halus ke sudut. 

 

• Dengan Direct Selection Tool (A), memindahkan merubah titik anchor di bawah. 
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• Menambahkan efek Drop Shadow pada pin. Gunakan pengaturan di bawah ini untuk 

membuatnya halus. 

 

• Sekali lagi, membuat Ellipse (U) baru dan dan warna Fill dengan putihTempatkan elips 

ke tengah pin. Dan itulah sentuhan akhir untuk desain brosur kami. 
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Setiap kali Anda merancang gambar untuk cetak digital, Anda harus berpikir 

warna CMYK untuk mencapai hasil terbaik. Jangan lupa untuk menambahkan bleed 
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ke kanvas (minimal 3 mm dari setiap ujung). Jika Anda tidak yakin tentang beberapa 

parameter teknis lanjutan, selalu baik untuk berkonsultasi langsung dengan perusahaan 

percetakan untuk menghindari kesalahan atau masalah. 

 

B. Evaluasi 

1. Jelaskan perbedaan gambar vector dan bitmap! 

2. Apa yang harus menjadi pertimbangan dalam membuat desain menggunakan gambar 

vector atau bitmap! 

3. Buatlah satu contoh desain brosur menggunakan aplikasi coreldraw atau photoshop! 
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